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CATIA V5 Fundamentals Your Notes:



Lesson 1: Introduction Introduction to CATIA Student book reference: Student Guide: Introduction to CATIA



Talk to the students: Introduce the course. Explain the prerequisites for this course. Mention the course duration (5 days). You should view the student manual as a supplement to, not a replacement for, the system documentation and on-line help. Once you have developed a good foundation in basic skills, you can refer to the on-line help for information on less frequently used command options. There are several other courses you can take to further develop and enhance your CATIA knowledge and skills. Please visit http://plm.3ds.com/education for a complete listing.



Class Agenda Talk to the students: Introduce the agenda for the week.



Objectives of the Day Talk to the students: Explain briefly the day’s objective and how this enables you to fulfill a part of the overall objective. Explain that each day has an objective, presented like this.



Case Study Student book reference: Student Guide: Case Study: Introduction to CATIA, Design Intent, Stages in the Process



Talk to the students:



Discuss the case study concept. Individual case studies are used as building blocks towards the completion of a final design project. Not every component in the master project will be created from scratch, some will be used at various stages of their design. Case studies and exercises in the course do not necessarily reflect real world examples. They are created to demonstrate the many tools CATIA has to offer.
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CATIA V5 Fundamentals Your Notes: Understand the CATIA Software Student book reference: Student Guide: Step 1: Understand the CATIA Software.



Talk to the students:



Introduce the first step.



PLM – Product Lifecycle Management Student book reference: Student Guide: PLM – Product Lifecycle Management



Talk to the students: Introduce PLM. Product Lifecycle Management (PLM) is one of the greatest emerging goals in collaborative engineering and manufacturing. In short, PLM is what happens when every piece of information about a product is organized and correlated right from specifications, quality history, process history, customer complaints, costs, genealogy, product development history, research and development results, and sales history.



PLM in Practice Student book reference: Student Guide: PLM in Practice



Talk to the students:



The real value of PLM is realized in the ability to put context around all your product data and systems.



CATIA Within the PLM Solution Student book reference: Student Guide: CATIA Within the PLM Solution



Talk to the students:



Review the PLM solution.



Ask the students: There are several other functions that can also be considered. Can you name a few?
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CATIA V5 Fundamentals Your Notes: CATIA Coverage Student book reference: Student Guide: CATIA From Concept To Realization



Talk to the students:



Discuss the order of product production and how CATIA fits in to the process.



What is CATIA V5? Student book reference: Student Guide: What is CATIA V5? and Key Terms



Talk to the students:



Discuss what CATIA is. Have a discussion about what the terminology means. Try to encourage the students to give their own definitions. See student guide for full definitions.



Design Intent (1/3) Student book reference: Student Guide: Design Intent (1/3)



Talk to the students: Discuss what design intent is and why it is important. Changing the design intent in a solid model can be very time consuming and costly, therefore adequate planning and time should be given to understanding the design intent before you begin to create the feature elements to represent the part. *Automatic Relations: Based on how geometry is sketched, these relations can provided common geometric relationships between objects (tangency, parallel, perpendicular, horizontal, vertical, etc.) *Equations: Used to relate dimensions algebraically. They are an external way to force change. *Additional relations: Other relations added to the model as it is created to connect related geometry. (concentric, coincident, offset, etc.). *Dimensioning: The way a sketch is dimensioned will have an impact on the design intent. Dimensions should be added in such as way that when they are changed they control elements correctly.
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CATIA V5 Fundamentals Your Notes: Design Intent (2/3) Student book reference: Student Guide: Design Intent (2/3)



Talk to the students:



Discuss the ways to dimension a model. While each method can meet a valid design intent, only one method can be chosen for the model. Therefore careful planning must be taken into account to ensure the appropriate method is selected. A sketch dimensioned like this will keep the holes 20mm from each end regardless of how the overall plate width, 110mm, is changed. Baseline dimensions like this will keep the holes positioned relative to the left edge of the plate. The positions of the holes are not affected by changes in the overall width of the plate. Dimensioning from the edge and from center to center will maintain the distance from the left edge and between the hole centers and allow it to be changed that way.



Design Intent (3/3) Student book reference: Student Guide: Design Intent (3/3)



Talk to the students:



The example shows a simple hand-drawn sketch of a modeling plan that details the complete design intent of the part. This type of pre-planning, before starting to model the part within the software, is an excellent strategy to ensure the desired outcome is clear and precise. Through pre-planning, you can become efficient at creating a robust model design that provides flexibility and maintains stability during any modifications.



How Features affect Design Intent (1/2) Student book reference: Student Guide: How Features Affect Design Intent (1/2)



Talk to the students: Three of the most common methods are shown here. "Layered" Approach: Builds the part one piece at a time, adding a layer or feature onto the previous one until the desired solution is obtained. Changing the thickness or shape of one layer has a ripple effect; it changes the position or location of all the other layers that were created after it.
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CATIA V5 Fundamentals Your Notes: How Features affect Design Intent (2/2) Student book reference: Student Guide: How Features Affect Design Intent (2/2)



Talk to the students:



Potter’s Wheel: The potter' s wheel approach builds the part as a single, revolved feature. A single sketch, representing the crosssection, includes all the information and dimensions necessary to make the part as one feature. While this approach may seem the most efficient, having all the design information contained within a single feature limits flexibility and can make changes difficult. Manufacturing: The manufacturing approach to modeling mimics the way the part would be manufactured. For example, if this stepped shaft was turned on a lathe, you would start with a piece of bar stock and remove material using a series of cuts. *Another approach not shown here is a combination of these three methods. *This course will focus only on one modeling approach. Please check the design practices of your company to determine which approach will be preferred for your final design work.



Ask the students: Ensure there are no questions before starting the first exercise.



Exercise Overview Student book reference: Student Guide: Exercise Design Intent



Talk to the students:



==> Present the assessment as an unmarked test. Tests will be incorporated at the end of each lesson so that students can check their progress. ==> As a class discuss what would be the design intent in the parts.



Open CATIA Student book reference: Student Guide: Step 2: Open CATIA.



Talk to the students:



Introduce the next step.
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CATIA V5 Fundamentals Your Notes: Starting CATIA Using the Start Menu Student book reference: Student Guide: Starting CATIA using the Start Menu



Talk to the students:



Discuss the different ways to start a CATIA session. Companies may decide to create other launch methods which can integrate better within their systems environment. Please refer to your company’s CATIA administrator to determine the correct method.



Opening an Existing Document Student book reference: Student Guide: Opening an Existing Document



Talk to the students:



Identify the steps used to open an existing file in CATIA. The list of document types you can open depends on the configurations/ products installed and for which you have a current license. The way with which you open a document may depend upon your company’s system environment. Please refer to your company’s CATIA administrator to determine the correct method.



Understand the CATIA Interface Student book reference: Student Guide: Step 3: Understand the CATIA interface.



Talk to the students:



Introduce the next step.
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CATIA V5 Fundamentals Your Notes: The Windows Philosophy (1/3) Student book reference: Student Guide: Windows Philosophy (1/4) and (2/4)



Talk to the students:



CATIA V5 is specifically designed for the Windows operating environment, and behaves in the same manner as other Windows applications. Traditional menu pull-downs provide access to all the CATIA commands. Some pull-down menu options have additional options related to them: ==>An arrow pointing right indicates a sub-menu. ==>A menu followed by a series of dots indicates that selecting that command will open a window with additional options. *Toolbars contain icons for quick access to the most frequently used commands. Toolbars are organized into workbenches. They can be customized, rearranged, and relocated to your preferences. For example, the Standard toolbar contains commands to open, save, print, cut, undo, and to access on-line documentation. *Within a toolbar An arrow beside a command means there is more tools of the same type available. *CATIA conforms to standard keyboard shortcuts consistent with the Windows philosophy, such as +, +, +, +, etc.



The Windows Philosophy (2/3) Student book reference: Student Guide: Windows Philosophy (3/4)



Talk to the students: CATIA V5 utilizes a three button mouse for the selection and indication of input from the user. Below is the general functionality of the mouse buttons. A complete description of their use will be covered later. ==>The left mouse button is used to the select displayed elements or items on the screen. ==>The middle mouse button (or the thumb wheel) is used to indicate or point to a direction on the screen. ==>The right mouse button is used to display a contextual menu for the currently selected or pre-selected elements on the screen. Using a windows mouse control panel item, the mouse buttons may be reversed for the users who are left-handed. A combination of mouse buttons may also be used to perform some additional user interface interactions. These will be covered later in the course.
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CATIA V5 Fundamentals Your Notes: The Windows Philosophy (3/3) Student book reference: Student Guide: Windows Philosophy (4/4)



Talk to the students:



CATIA provides various levels of system feedback to users, such as the following: ==>Different symbols may represent the mouse cursor to indicate different status. ==>Various message panels may appear to convey information about the progress, failure, or result that occurred for a requested procedure. ==>Tool tips and a short help message appear when the cursor hovers over the tools (without selecting it). The cursor symbols may be changed using the standard Windows capabilities. You can switch tool tip display on and off using the Tool tips option of the Options tab in the Tools > Customize.



Introduction to V5 Documents Student book reference: Student Guide: Introduction to V5 Documents



Talk to the students: CATIA has a wide variety of documents that can be created, modified, and saved. All geometry and specifications that define an object are described within these documents. The most common documents (covered within this course) include the following: ==>A part document (.CATPart) ==>An assembly document (.CATProduct) ==>A drawing document (.CATDrawing) Each document type is controlled via the normal Windows convention of having different extensions for different file types.
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CATIA V5 Fundamentals Your Notes: The Workbench Concept Student book reference: Student Guide: The Workbench Concept



Talk to the students:



Part Design: To design parts using a solid modeling approach. Sketcher: To create 2D profiles with associated constraints that is utilized in the creation of other 3D geometry Wireframe & Surface: To create any complex part features with 3D wireframe and surface elements Assembly Design: To create constraints, features and specifications for parts in the context of an assembly Generative & Interactive Drafting: To create drawings from part and assembly designs Discuss the types of files that can be opened with each workbench. (e.g., part design, surface &wireframe open CATPart). Notice how each document has a title bar with the name and type being displayed. Workbenches are grouped into product configurations, where they support a single discipline. For example, the workbenches shown here is for the Mechanical Design discipline.



CATIA User Interface (1/2) Student book reference: Student Guide: CATIA User Interface (1/2)



Talk to the students: Discuss the key features of CATIA. Students are used to the traditional menu-driven systems. To help them migrate to the workbench/toolbar system, most of the commands within CATIA are available in both forms - menu items and toolbar icons.



CATIA User Interface (2/2) Student book reference: Student Guide: CATIA User Interface (2/2)



Talk to the students:



Discuss the key features to the CATIA layout. You can easily customize the look of your CATIA session by changing the layout of the CATIA window. You can hide or display toolbars and move them to different locations on the screen.
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CATIA V5 Fundamentals Your Notes: Workbenches (1/2) Student book reference: Student Guide: Workbenches



Talk to the students:



Workbenches contain various functionality that you may need to access during your part creation. You can tell which workbench you are currently in by the icon displayed in the upper right corner of the window. The icon background image will also denote what Solution this workbench is found within. For example the Green Triangle one here indicates the Mechanical Design Solution.



Workbenches (2/2) Student book reference: Student Guide: Workbenches



Talk to the students: Workbenches contain various functionality that you may need to access during your part creation. You can tell which workbench you are currently in by the icon displayed in the upper right corner of the window. The icon background image will also denote what Solution this workbench is found within. For example the Green Triangle one here indicates the Mechanical Design Solution.



Menus and Toolbars (1/2) Student book reference: Student Guide: Menus and Toolbars (1/2)



Talk to the students:



Toolbars provide quick access to tools which are also available in menus. Identify the steps to activate/deactivate a toolbar. The Activated toolbars are displayed with a check mark beside them. You can also use the right (#3) mouse button in the prompt zone to quickly access the toolbar list. Toolbars can be docked onto the sides of the screen or float free.
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CATIA V5 Fundamentals Your Notes: Menus and Toolbars (2/2) Student book reference: Student Guide: Menus and Toolbars (2/2)



Talk to the students:



The toolbars can be further manipulated. They can be closed, reorganized, or expanded. ==>To close a floating toolbar, select Close. ==> Reorganize the toolbars by dragging the separator to move the toolbar anywhere. ==> Double arrows mean that there are more toolbars available but can not currently be seen due to the window size. Drag the >> sign to move unseen toolbars. The term “Drag“ is used to refer to the process of selecting the item with the left (#1) mouse button and holding this button down while moving the cursor across the screen to a new location. Where upon reaching the new location the mouse button is released. You can reset the original toolbar configuration. Click Tools > Customize and the Toolbars tab; click the Restore Position button. The floating toolbar will be reset to its original fixed position.



What to Do When a Tool Cannot be Found Student book reference: Student Guide: Finding Tools



Talk to the students: With the number of tools and toolbars that CATIA contains, it is not possible to display all within the normal borders of the main screen. CATIA manages this through collapsible toolbars and stacking extra toolbars at the screen borders. If you are unable to find a toolbar ensure: ==> The tool you are looking for is not located as a “fly out” optional tool. CATIA will group variants of the same tool into a single display group. ==> The tool/toolbar is not located outside the display. Look for the >> symbols at the corner of the screen. You can drag the toolbars out from this area to see the remaining tools in the toolbar. You may also have to drag several toolbars out to the screen before the one you are looking for will appear. ==> The toolbar is active.
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CATIA V5 Fundamentals Your Notes: The Specification Tree Student book reference: Student Guide: The Specification Tree



Talk to the students:



CATIA V5 provides a specification tree, which keeps the hierarchy of features, constraints, process, and assembly information for a CATIA document. The specification tree provides a visual record of the sequence used in the creation of a solid model. You can edit, reorder, or remove steps in the design process and specifications to achieve a new finished part without having to recreate the model. The specification tree can suppress certain features and information by temporarily removing them from consideration for the model. The structure and content of the Specification Tree will change depending on the document being edited. The Specification Tree can also contain information that is not represented by a geometric element on the display screen (I.e. Designer Name, Material type, Date Created, etc…)



Manipulating the Specification Tree Student book reference: Student Guide: Manipulating the Specification Tree



Talk to the students: The Specification tree may also be larger and smaller by zooming in and out on it. Select the tree and then select the Zoom In/Out tools. The Specification Tree can also be used to select an element for processing instead of always picking it‘s geometric shape. Each item on the tree is called a Node and any sub pieces to a node is called a leaf. The specification tree may also be larger and smaller by zooming in and out on it. Select the tree and then select the Zoom In/Out tools from the View toolbar. The specification tree can also be used to select an element for processing instead or always picking it‘s geometric shape. Each item on the tree is called a node and any sub-piece to a node is called a leaf.
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CATIA V5 Fundamentals Your Notes: Selecting Objects With the Mouse Student book reference: Student Guide: Selecting Objects with the Mouse, The Preselection Navigator



Talk to the students: CATIA, like any other Windows environment application, has an interface that is primarily mouse driven. When working in the software there are two ways to select items: ==> Simple Selection: To select an object press the left button of the mouse, also called Mouse Button 1 (MB1). You can select an object directly from the model or its corresponding feature in the tree. Selecting the geometry will highlight the tree feature and vice versa. ==> Multi-Selection: To multi-select, press the key while using the left mouse button to select the objects. Multi-selection can also be done by trapping objects within a selection area. ==> use the left/right arrows to activate the Pre-selection Navigator. Then the up/down arrows to scan the elements under the cursor, the left/right arrows to scan the model feature hierarchy.



The Object/Action and Action/Object Approaches Student book reference: Student Guide: The Action/Object and Object/Action Approaches



Talk to the students: CATIA is different than other Windows application in that you can control the order of selection for the elements and tools. You can either: ==> Object/Action: First select the object(s) to process, then select the tool defining the operation to perform. ==> Action/Object: First select the tool defining the operation to perform, then select the object(s) to process. Only one approach can be used at a time meaning you can not select an object and then the tool and then another object as one operation. Some specific operations might require that you use a specific approach to achieve the desired results.
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CATIA V5 Fundamentals Your Notes: Using Dialog Boxes Student book reference: Student Guide: Using the CATIA Dialog Boxes(1/2) and (2/2)



Talk to the students:



Dialog boxes provide parameters for the definition of features. They are standardized and easy to use to define the inputs for a feature or process. Typical things that you might find in a dialog box are shown. Most operations in CATIA will open a dialog box. The dialog box is simple to use and ensures that all the information needed to create the feature has data that you have provided. If there is an option in the dialog box that is unclear, you can click the question mark, then the field in question to get more information.



Using Dialog Boxes and Right-click Student book reference: Student Guide: Using Dialog Boxes and Right-click



Talk to the students:



Data can also be entered into certain fields within dialog boxes using the Windows functionality of pressing the right mouse button (right clicking) in a field. The options that appear in the Contextual Menu are dependent on the data the field is capable to receive. By Right Clicking in a value field you can enter a value based on a mathematical formula or find the value by performing a measurement of an item or items. You can also create geometric elements that might be missing to provide input. For example, a point for the center point of a hole.



Moving Objects With the Mouse Student book reference: Student Guide: Moving Objects with the Mouse (1/3),(2/3), (3/3)



Talk to the students: Since CATIA is a 3-D environment there are various ways of viewing the model. The easiest way to change the view of the model is called Panning, Rotating and Zooming. Discuss how to pan, zoom and rotate a model. Panning moves the current mouse position to the location where the mouse button was released. When Rotating the model, it is best to locate the mouse in the center of the screen before performing the mouse commands. This will allow you the most freedom in rotating the model. A single click on the middle mouse button with the cursor positioned on geometry will center the geometry on the screen (panning) with no change to zoom or orientation. Use Fit All In to see all displayed objects.
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CATIA V5 Fundamentals Your Notes: What is the Compass? Student book reference: Student Guide: Compass



Talk to the students:



Besides being an orientation reference tool when performing view rotations, the Compass is a powerful tool that can be used to physically move and manipulate objects. This is especially useful within the Assembly Design, Freestyle, and Digital Mockup workbenches. The Base of the Compass (or privileged plane) is, by default, the XY plane. The default orientation of the Compass is parallel to the reference XYZ axis system and is located to the top right corner of the screen. After a view rotation has occurred the Compass will update to reflect the new viewing angle/direction that is currently seen within the geometric area of the window. The use of the Compass is explained in detail within the Assembly Design workbench or within the Product Design lesson within this course.



Graphic Properties Student book reference: Student Guide: Graphic Properties



Talk to the students:



The Graphic Properties toolbar allows you to change the various graphic properties of elements as they are being displayed on the screen. The Painter tool works opposite as compared to those found in other Windows applications. First select the destination element and then select the element which will define the graphic properties.



Changing the Graphic Properties Student book reference: Student Guide: Changing the Graphic Properties



Talk to the students: Identify the steps to change graphic properties. Color can also be changed using the Graphics toolbar as shown on the last slide. You can also change the properties by selecting the element (s) from the specification tree.
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CATIA V5 Fundamentals Your Notes: Rendering Styles Student book reference: Student Guide: Rendering Styles and Applying Rendering Styles



Talk to the students:



CATIA has the ability to apply different styles of rendering to visualize the geometry which could provide better clarity to the model. Identify the steps to apply a rendering style: ==> Select the current rendering style within the View toolbar. ==> Select a new rendering style to apply. It will be applied automatically to the geometry. Shading mode with or without edges are typically used for everyday work. Shading with Material is applied to a part to give a realistic look.



CATIA User Companion Student book reference: Student Guide: CATIA User Companion



Talk to the students:



The main focus of workplace learning is through the User Companion. The Companion is a self-contained series of learning objects, that aims to allow you to learn at your own pace, to get some additional knowledge or some extra practice on the following topics: - CATIA V5 (Mechanical Design, Hybrid Design, Generative Sheet Metal Design, Analysis) - DMU - ENOVIA - SMARTEAM The way in which Companion is launched will depend upon your company’s system configuration.
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CATIA V5 Fundamentals Your Notes: Help Documentation Student book reference: Student Guide: Help Documentation



Talk to the students:



CATIA contains many assets to assist the user in learning the finer details of all the functionality and tools. The main source of information is through the on-line Help documentation. It is a self contained series of html documents that break down information through workbenches, products and solutions. To access the on-line Help documentation, select the Help > CATIA V5 Help menu or press the key. The documentation may also be installed on a web-server or can be opened separately through a html file located in the local file directory. If you have problems, please contact your local support desk to find the correct location for your on-line documentation.



Message Bar Student book reference: Student Guide: Message Bar



Talk to the students: Another useful tool that can aid the user in determining what is required when trying to perform a command is through the message toolbar. When selecting a tool, CATIA will prompt for the particular inputs that are needed to complete a command.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Exercise: CATIA V5 User Interface



Show the students:



Demonstrate the topics learned in this lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. The demonstration should include: launching CATIA, opening an existing part file, modifying the toolbar locations (including changing from docked to floating, turning on/off, adding another row to the docked toolbars, and resetting the toolbar locations from the customize dialog box). Demonstrate how to change graphical properties using other the graphics toolbar and the properties dialog box. Use the orientation tools (both the mouse and the icons). Review and modify the specification tree.



Talk to the students: ==> Present the exercise available to practice simplifying screen display and investigating the model. ==> As a class, discuss what will be involved in completing the exercise. What tools will they need to use? ==> Tell students where the required start parts are located.



Case Study: Introduction to CATIA Student book reference: Student Guide: Case Study: Introduction to CATIA



Talk to the students: Review the requirements for the case study. As a class, discuss how the model will be created, what tools are needed to complete the case study? Other remarks Tell the students to do the exercises, and note the time. If needed, assist the students in doing the exercises.



CATIA V5 User Interface: Recap Student book reference: Student Guide: CATIA V5 User Interface: Recap



Show the students: Review the Exercise Recap slides after the students have attempted the exercises. Try to encourage group discussion on the exercises they have just completed. Discuss the different tools used.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Fundamentals Your Notes: Case Study: Introduction to CATIA Recap Student book reference: Student Guide: Case Study: Introduction to CATIA Recap



Talk to the students:



Discuss the objectives of the case study.



Before proceeding to the next lesson, ensure that the students have understood the process used to complete the Case Study.
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Course Title Your Notes:
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CATIA V5 Fundamentals Your Notes:



Lesson 2: Profile Creation Profile Creation Student book reference: Student Guide: Profile Creation



Talk to the students: Introduce the lesson. Present the lesson objectives and topics.



Case Study Student book reference: Student Guide: Case Study: Profile Creation, Design Intent



Talk to the students:



Introduce the case study for this lesson. The support plaque is part of the drill support sub-assembly. Locate where the support plaque is in the sub-assembly and where the sub-assembly is in the main assembly. Identify the design intent for this model ==>The model must be created in one feature. While this is not typical practice, in this case it is a requirement. Note that internal profiles are typically made as seperate features (pockets or holes). ==>The center hole must remain in the center of the support. This requirement can be met by creating a rectangular profile, symmetric about the part origin and locating the center of the circle (representing the hole) at the origin. ==>The smaller holes must be 30mm away from the center hole. Constraining the three small holes on a construction circle, that is 60mm in diameter, will ensure this requirement is met.



Stages in the Process Student book reference: Student Guide: Stages in the Process



Talk to the students:



Identify the stages in the process.



Create a New Part Student book reference: Student Guide: Step 1: Create a New Part



Talk to the students: Introduce the first step, creating a new part.
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CATIA V5 Fundamentals Your Notes: Methods to Create a New Part Student book reference: Student Guide: Creating a New Part



Talk to the students:



Use the following method to create a new part file: ==>Use any of the following: Click Start > Mechanical Design > Part design. Click File > New and select Part from the New dialog box. Select the New icon from the Standard toolbar and select Part from the New dialog box. ==> Enter a name for the part. ==> Select OK. Note the extension of a part file.



Part Design Workbench Student book reference: Student Guide: Part Design Workbench



Talk to the students:



When you create a new part, the Part Design workbench is opened. The workbench contains the tools needed to create a solid 3D model. When it is first opened, only three default reference planes are displayed (more on the planes in the next step). Note that many of the tools are grayed out. Only features that build material are available to create the first feature with (i.e., the pocket option is not available because there is no solid material in the model to remove yet).



Ask the students: Ensure there are no questions before moving onto the next step.



Select an Appropriate Sketch Support Student book reference: Student Guide: Step 2: Select an Appropriate Sketch Support



Talk to the students: Introduce the next step in profile creation, i. E., selecting an approprate sketch support.
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CATIA V5 Fundamentals Your Notes: Sketch Creation Student book reference: Student Guide: Reference Planes, What is a Sketch?



Talk to the students:



When a model is first opened, the only features in the model are the three default reference planes. These planes are in every part file (XY, YZ, and ZX planes). Use the default reference planes to sketch your first (and other) profile on. Every part begins with a 2D profile that can be created in the Sketcher workbench. In the Part Design workbench, the geometry created in the Sketcher workbench is seen as a single entity called “the Sketch“. Use the sketch as a profile to create 3D features in the Part Design workbench.



The Sketch Support Student book reference: Student Guide: Sketch Support (1/2), (2/2)



Talk to the students: To access the Sketcher workbench and create the profile you need to first select a sketch support. A sketch support is the plane on which the sketch is created on. It can be a reference plane or a plannar surface of existing geometry. For the first feature, the profile is typically created on one of the 3 default reference planes. The choice of sketch support depends on how you want the model to be oriented. The YZ plane is considered the ' front'view, as defined by the Quick Views already discussed in lesson 1.



Ask the students:



Ensure there are no questions before moving onto the next step.



Create Sketched Geometry Student book reference: Student Guide: Step 3: Create Sketched Geometry



Talk to the students: Introduce the next step in profile creation, creating the sketched geometry.
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CATIA V5 Fundamentals Your Notes: Sketching Student book reference: Student Guide: Basic Sketching, Positioned Sketching, Sketcher Workbench



Talk to the students: The Sketcher workbench is built to facilitate the creation of 2D profiles. It is accessed from within other workbenches such as the Part Design workbench.



Show the students: Review how to access the Sketcher workbench using Sketcher and Positioned Sketch icons. Key features of the Sketcher workbench: ==>The Grid: Guides you while you are creating profiles. ==>The Profile toolbar: Used to create geometry. ==>The Constraint toolbar: Used to dimension and constrain the sketch. ==>The Sketch Tools toolbar: A floating toolbar (by default) that displays options available during geometry creation. Options within the toolbar vary depending on the geometry being created.



Grid Student book reference: Student Guide: Grid



Talk to the students: The grid is applied to the background of the Sketcher workbench. It is used to define the scale of sketched entities. Snap to Point: When active, the mouse cursor snaps to the points of the grid. Temporarily disable it by deactivating the Snap to Point icon. You can change grid properties from the Options dialog box. ==>Toggle the grid on and off ==>Permanently activate/deactivate the Snap to Point option. ==>Change the Primary spacing and the Graduations of the grid.
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CATIA V5 Fundamentals Your Notes: Construction Geometry Student book reference: Student Guide: Construction Geometry



Talk to the students:



Construction geometry is used within a sketch to aid in profile creation. It is not visible outside the Sketcher workbench. Any standard sketched geometry can be converted into a construction element by selecting the Construction/Standard Element icon. If you create geometry while the icon is active it will be created as construction. Construction geoemtry is distinguished from standard elements by its dashed format. In the example shown two infinite lines are created as construction geometry and can be used to help construct a symmetrical shape.



Ask the students:



Ensure there are no questions before moving onto the recommendations.



Exercise Overview Student book reference: Student Guide: Profile Creation (Detailed Instructions), Profile Creation (Limited Instructions), Multiple Profile Creation



Talk to the students: Inform the students where they have to save the models. State that they are to move from one exercise to the next and complete all three (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd exercise. The final exercise provides no instruction. Tell the students to do the exercises and, if possible, note the time they take to complete them. Assist the students to perform the exercises as and when needed.



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. Present the exercises available to practice creating sketched profiles.



Ask the students: As a class, discuss what will be involved in completing the exercises. What tools will they need to use?
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CATIA V5 Fundamentals Your Notes: Profile Creation (Detailed Instructions): Recap Student book reference: Student Guide: Profile Creation (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Try to encourage group discussion on the exercises they have just completed. This exercise is used to practice creating profiles in the Sketcher workbench.



Ask the students: Discuss the different tools used.



Ask the students:



Ask if there are any questions regarding this exercise? Any difficulties?



Profile Creation (Limited Instructions): Recap Student book reference: Student Guide: Profile Creation (Limited Instructions): Recap



Talk to the students:



This exercise is used to practice creating a profile and using the relimitation tools in the Sketcher workbench.



Ask the students: Discuss the different tools used. Discuss the uses for this profile in the Part Design workbench. Creating Shafts will be taught in Lesson 4.



Multiple Profile Creation: Recap Student book reference: Student Guide: Multiple Profile Creation: Recap



Talk to the students:



In this exercise the student must use the skills they have developed to determine the best way to create the profile. No instruction is provided.



Ask the students:



Discuss the different methods that could have been used to create this profile. Discuss the different tools used. Did different students use different tools?
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CATIA V5 Fundamentals Your Notes: Constrain the Sketch Student book reference: Student Guide: Step 4: Constrain the Sketch



Talk to the students:



Introduce the next step in profile creation, constraining the sketch.



Constraining the Sketch Student book reference: Student Guide: Constraining the Sketch



Talk to the students: Once the sketched profile is created, the next step is to constrain it. Constraints serve to mathematically fix geometry in space. Without constraints, geometry can be moved using the mouse. When the sketched profile is moved, the solids that are supported by them are also moved. Without constraints, feature creation becomes unpredictable and modifications to the model may adversly affect form, fit and function of the assemblies. Constraints are used to relate one element to another and itself in a logical way. With constraints profiles can be modified easily.



What are Geometric and Dimensional Constraints? Student book reference: Student Guide: Geometric and Dimensional Constraints



Talk to the students: Constraints are added to sketched geometry inside the Sketcher workbench. There are two types of constraints: ==>Geometric constraints: Specify how sketched elments are positioned with respect to each other and existing geometry. ==>Dimensional constraints: Specifiy the distance between two elements. Distance can be linear, angular or radial depending on the elements involved. Use the Constraint Defined in Dialog Box icon to create geometric constraints. The icon will be grayed out until the entitites to constrain are pre-selected. Select the entities to constrain (use the key to multi-select), then select the icon. The Constraints dialog box will only display applicable constraints for the selected entities. Use the Constraint icon to create dimensional constraints. Select the icon then select the entities to dimension.
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CATIA V5 Fundamentals Your Notes: Fully-Constrained Sketches Student book reference: Student Guide: Lesson4- Fully Constrained Sketches



Talk to the students:



The color of a sketch indicates its status. Green – Iso-constrained elements White – Under-constrained elements Purple – Over-constrained elements Red – Inconsistent elements Ideally, sketches should be green when completed. This indicates that the size and location of the sketch have been clearly defined. You can create 3D geometry with under constrained sketches, however, design intent may not be maintained. Discuss graphics to illustrate this point. Lists of the types of geometric and dimensional constraints are in the following page of the student guide - Geometric Constraints, Dimensional Constraints



Ask the students: Ensure there are no questions before moving onto recommendations.



Sketch in Context Student book reference: Student Guide: Sketch in Context (1/2), (2/2)



Talk to the students: Always keep the design intent in your mind while sketching. Dimension and constrain accordingly. Use existing model elements to constrain the sketch.



Show the students:



Review example: Pocket must remain 15mm away from the right hand side of the base feature.
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CATIA V5 Fundamentals Your Notes: Sketcher Orientation Student book reference: Student Guide: Sketcher Orientation (1/2), (2/2)



Talk to the students:



It is better to rotate the model into a 3D view while dimensioning to existing 3D elements. This will ensure the correct 3D element is selected. For example: The 30mm dimension is supposed to be to the top of the base feature. If the dimension is placed while in Normal view, CATIA will constrain to the ' first'edge. In this case, it is a filleted edge and not the top surface. In a 3D orientation, the proper selection can be ensured. Discuss parent-child implications of selecting the wrong reference for dimensioning.



Ask the students: If the dimension was to the fillet, what would happen to the profile if the fillet is deleted?



Tips on Initial Sketch Geometry Student book reference: Student Guide: Tips on Initial Sketch Geometry (1/2), (2/2)



Talk to the students: While sketching, try to create the geometry as reasonably close in shape and size to the final constrained sketch. Sketches that are greatly different from the desired profile may become distorted when the final dimensional constraints are applied. This makes it difficult to fully constrain the sketch. Consider using the grid to help maintain proper scale. As you are sketching you can also use the Sketch Tools toolbar to understand the real size of the elements. When you are sketching, the Geometrical Constraints icon controls whether geometric constraint are created automatically. ==>When the sketch is simple, it is advantageous to have this tool selected. It speeds up the process of constraining the sketch. ==> In more complex sketches, having this tool active can lead to confusion and the potential for the creation of unwanted constraints.
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CATIA V5 Fundamentals Your Notes: Tips on Constraint Creation Student book reference: Student Guide: Tips on Constraint Creation



Talk to the students:



Constraints can be created using either constraint tool. However, typically Geometric constraints are created with the Constraint Define in Dialog Box icon and dimensional constraints are created using the Quick Constraint icon. As students become more skilled, they may find it more efficent to create both types of constraints using the Quick Constraint icon. While creating the constraint, use the right mouse button pop-up menu to select a different type of constraint. Only appropriate constraints will display in the pop-up menu.



Controlling the Constraint Dimension Direction Student book reference: Student Guide: Controlling the Constraint Dimension Direction



Talk to the students: The Direction of dimensional constraints is controlled by the type of element selected. Use the right mouse button pop-up menu while creating dimensions to change the orientation of the dimension.



Show the students: Create a sample part file containing a base feature with a fillet. Create a profile and use the base feature to dimension the new profile. Demonstrate the need to rotate a model to ensure proper reference selection. Demonstrate dimensioning and geometric constraint techniques.



Create the Pad Feature Student book reference: Student Guide: Step 5: Create the Pad Feature



Talk to the students: Introduce the next step in profile creation, creating the pad feature.
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CATIA V5 Fundamentals Your Notes: Complete the Feature Student book reference: Student Guide: Completing the Feature, Using a Pad to Create the First Feature



Talk to the students: Once the profile is created and fully constrained it can be used to create 3D solid geometry in the Part Design workbench. A pad is a simple 3D feature that extrudes the sketched profile normal to the sketch support. Identify the steps used to create a simple pad feature.



Save and Close the Document Student book reference: Student Guide: Save and Close the Document



Talk to the students: Introduce the next step in profile creation, saving and closing the document.



Saving Documents Student book reference: Student Guide: Saving Documents, Saving a Document with the Same Name, Saving a Document with a New Name



Talk to the students: Clicking File > Save or selecting the Save icon is used to save a part with the same name in the same folder. The Save As command is used to save an existing document under a new name. Save As creates a copy of the existing document. It does not remove the original document. The first time a document is saved, CATIA will open the Save As dialog box regardless of the tool selected. Note that how a document will be saved will be dependent upon the company configuration (if PLM system installed)



Show the students: Review the steps to save a document for the first time: ==>Click File > Save or File > Save As or select the Save icon from the Standard toolbar. ==>From the Save As dialog box browse to the directory where the file is to be saved. ==>Name the document.
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CATIA V5 Fundamentals Your Notes: Closing a Document Student book reference: Student Guide: Closing a Document



Talk to the students:



Review steps to close a document.



Exercise Overview Student book reference: Student Guide: Exercise: Sketch Constraints (Detailed Instructions), Exercise: Sketch Constraints (Limited Instructions), Exercise: Sketch Constraints



Show the students:



* Demonstrate the topics learned in this half of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. * Present the exercises available to practice creating and constraining sketches.



Ask the students: * As a class, discuss what will be involved in completing the exercises. What tools will they need to use?



Talk to the students:



* Inform the students where they have to save the models and where necessary start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting). * Inform the Students: To meet the purpose of this exercise, the sketch used represents a part having an all-in-one profile (fillets, holes, etc.). Generally, for complex parts, it is recommended to simplify the sketches and to use dedicated 3D features like fillets, chamfers, holes, drafts, etc. to better fit the Design and Manufacturing intents.



Case Study: Profile Creation Student book reference: Student Guide: Case Study: Profile Creation



Talk to the students: Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Ask the students to do the exercises and, if possible, note the time they take to complete them. Assist the students to perform the exercises as and when needed.
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CATIA V5 Fundamentals Your Notes: Sketch Constraints (Detailed Instructions): Recap Student book reference: Student Guide: Exercise 2D: Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Try to encourage group discussion on the exercises they have just completed. This exercise is used to practice fully constraining a sketch. Discuss the different tools used.



Ask the students:



Ask if there are any questions regarding this exercise? Any difficulties?



Sketch Constraints (Limited Instructions): Recap Student book reference: Student Guide: Exercise 2E: Recap



Talk to the students:



This exercise is designed to help the students understand the importance of proper sketch creation techniques. Discuss the different tools used. Discuss why the second sketch was harder to constrain as compared to the first? What about the second sketch makes it more difficult to constrain? Key idea: When sketching remember to create the sketch in the approximate shape and size to the final outcome. Taking the time to create the sketch properly will help save time when constraining.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Sketch Constraints: Recap Student book reference: Student Guide: Exercise 2F: Recap



Talk to the students: In this exercise the student must use the skills they have developed to determine the best way to create and constrain the profile. No instruction is provided. Discuss the different methods that could have been used to create this profile. Discuss the different tools used. Did different students use different tools?



Ask the students:



Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Case Study: Profile Creation Recap Student book reference: Student Guide: Case Study: Support Plaque Recap



Talk to the students:



Discuss the objectives of the case study. Review the process used to create the Support Plaque. Discuss the benifits and negatives of creating the internal loops and corners within the sketch.
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CATIA V5 Fundamentals Your Notes:



Lesson 3: Basic Features Basic Features Student book reference: Student guide: Basic Features



Talk to the students: Introduce the lesson. Present the lesson objectives and topics.



Basic Features in Part Design Student book reference: Student Guide: Basic Features in Part Design



Talk to the students:



Review the features. Do not go into detail. Features will be discussed throughout the lesson.



Case Study Student book reference: Student Guide: Case Study: Basic Features, Design Intent



Talk to the students: Introduce the case study for this lesson. The engine support is part of the Bloc Engine sub-assembly. Locate where the engine support is in the sub-assembly and where the sub-assembly is in the main assembly. Identify the design intent for this model. 1.Each element on this model must be created as separate features. By creating each element separately, future modifications will be easier. 2.Typically, one hole is created first, then patterned to create the other three holes. Since the requirement is to have them created as one feature, a pocket has to be used. 3.The fillets and the chamfer cannot be created within the sketched profile; they must be created as separate features.



Stages in the Process Student book reference: Student Guide: Stages in the Process



Talk to the students: Identify the stages in the process.



COPYRIGHT DASSAULT SYSTEMES



37



CATIA V5 Fundamentals Your Notes: Determine a Suitable Base Feature Student book reference: Student Guide: Determine a Suitable Base Feature



Talk to the students:



Introduce the first step.



Part Design Terminology Student book reference: Student Guide: Part Design Terminology



Talk to the students: Identify the key features: A. Part: The document containing the model. The document can consist of one or more features and bodies. B. PartBody: A default container containing the features that make up a part. C. Feature: Elements that make up a part. They can be based on sketches (sketch-based) or features that build on existing elements (dress-up and transformation). They can also be generated from surfaces (surface-based). D. Pad: A solid feature created by extruding a sketched profile. E. Pocket: A feature that removes material by extruding a sketched profile. F. Hole: A feature that removes material through the extrusion of a circular profile. G. Fillet: A curved surface of a constant or variable radius that is tangent to, and that joins two surfaces. Together, these three surfaces form an inside corner or outside corner. H. Chamfer: A cut through the thickness of the feature at an angle, giving a sloping edge.
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CATIA V5 Fundamentals Your Notes: Selecting a Base Feature Student book reference: Student Guide: Creating a Base Feature, Selecting a Base Feature



Talk to the students:



It is important to begin with a strong base feature. Typically, this feature represents the primary shape or foundation, to and from which all the part geometry can be added or removed. The base feature usually starts from a sketch or surface element. This lesson describes how to create the base feature from a sketch. While selecting a base feature, it is recommended to select the basic elements that convey the primary shape or function of the part. This does not mean the level of detail for a base feature must be completely defined. For example, fillets, holes, pockets, or other features do not need to be originally created as part of the base feature sketch; these can be created later using another feature.



Ask the students: Ask the group to identify the base feature of the part in the slide and explain why they selected it. Two options would be acceptable:



Selecting a Base Feature - Exercise Student book reference: Student Guide: Selecting a Base Feature – Exercise



Talk to the students: Present this slide as an activity to the class. Divide the group into teams to take a part and quickly identify the possible different options for the Base feature, their preferred choice, and the reason for its selection.



Selecting a Base Feature - Answers Student book reference: Student Guide: Selecting a Base Feature – Answers



Talk to the students:



Discuss the suggested base features.



Ask the students: Did anyone decide on a different base feature. Discuss the validity of their base feature.
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CATIA V5 Fundamentals Your Notes: Features that Add or Remove Material Student book reference: Student Guide: Features that Add or Remove Material (1/2), (2/2)



Talk to the students:



Once the base feature is selected, it needs to be defined by adding or removing material to complete the design. Two types of CATIA features, those that add material and those that remove material. Briefly discuss the features. Pad, pocket and hole will be discuss in greater detail in this lesson. Shaft and groove will be discussed in greater detail in following lesson.



Ask the students: Ensure there are no questions about the first step before moving on to next step.



Create Pad and Pocket Features Student book reference: Student Guide: Create Pad and Pocket Features



Talk to the students: Introduce the next step.



Creating Pads and Pockets Student book reference: Student Guide: Creating Pads, Creating a Simple Pocket



Talk to the students: A pad is a sketched-based feature that adds material to a model. Identify the steps to create a simple pad feature. By default, the pad is created normal to the sketch plane. You can change the direction the pad is extruded by selecting the Reverse Direction icon. Discuss the results. The pad definition can be modified after creation by double-clicking on the pad geometry or product structure Once the pad feature is created, the profile sketch is automatically hidden from display. A pocket is a sketched-based feature that removes material from a model. Pockets can also be created from sketches including several profiles. These profiles must not intersect. Identify the steps to create a pocket. Discuss the results. Once the pocket feature is created, the profile sketch is automatically hidden from display.
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CATIA V5 Fundamentals Your Notes: Pad and Pocket Limits Student book reference: Student Guide: Pad and Pocket Limits



Talk to the students:



The length of a pad or pocket can be defined by dimensions or with respect to existing 3D limiting elements. If defined by a limiting element, the pad/pocket is associative to the element. Identify the types of depth options. Dimension depth is sometimes called Blind depth. Length may also be referred to as depth.



Restrictions for Pad/Pocket Profile Sketches Student book reference: Student Guide: Restrictions for Pad/Pocket Profile Sketches



Talk to the students:



In general, the profile sketch should consist of connecting entities that form a closed loop. Open loop profile sketches can only be used with the Thick option. These examples do not necessarily represent the best practice for sketching, as presented in the sketcher lesson.



Ask the students: Discuss the sketches. Ask the students which sketches they think are not valid and why? Top Graphics: Multiple profiles are acceptable, but cannot intersect each other when creating the base feature. Bottom Graphics: Open profiles are not allowed as the base feature in a part unless the Thick option is used.



Open Profiles Student book reference: Student Guide: Open Profiles



Talk to the students:



Open profiles can be used to create pads, pockets, or groove features. Consider using an open profile when existing geometry is available to limit the new feature. Using existing geometry to re-limit a feature eliminates the need to create and constrain additional sketched geometry. Always ensure that the re-limiting feature is stable. Major modifications or removal of the re-limiting feature will cause the profile to fail.



Ask the students: Ensure there are no questions about this step before moving on to the next.
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CATIA V5 Fundamentals Your Notes: Create Holes Student book reference: Student Guide: Create Holes



Talk to the students:



Introduce the next step.



What is a Hole? Student book reference: Student Guide: What is a Hole?, Using Pockets or Holes



Talk to the students: A hole removes circular material from an existing solid feature. A hole does not require a profile sketch. Like a pocket, its length can be defined using dimensions or with respect to existing 3D elements. When to use a hole/pocket ==>A hole can be created using the Pocket or Hole tool. A benefit of creating a hole using the Hole tool is you are not required to create a sketch because it is automatically created for you. ==>The Hole tool also allows you to include technological information, such as thread, angle bottom, and counter bore. ==> If there is a possibility that the profile for the cutout may change from circular to another shape then consider using a pocket instead of a hole. Hole placement is typically defined using one of two methods: A. Placement using a positioning sketch. B. Placement using pre-defined references.



Hole Creation Using a Positioning Sketch Student book reference: Student Guide: Hole Creation Using a Positioning Sketch



Talk to the students: Identify the steps to create a hole using a positioning sketch. Step1: The hole will be positioned under the cursor. Position the hole exactly in step 3. Discuss the results. The position of the hole can be changed at anytime by doubleclicking on the hole feature and selecting the Positioning Sketch icon.
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CATIA V5 Fundamentals Your Notes: Hole Creation Using Pre-defined References (1/2) Student book reference: Student Guide: Hole Creation Using Pre-defined References (1/2)



Talk to the students:



Identify the steps to create a hole using pre-defined references. Step 1: To multi-select, press and hold the key while selecting.



Hole Creation Using Pre-defined References (2/2) Student book reference: Student Guide: Hole Creation Using Pre-defined References (2/2)



Talk to the students: Identify the steps to create a hole using pre-defined references. Discuss the results. You can edit the definition of the hole by double-clicking on the hole either in the model or the specification tree. You can also modify the location of the hole at anytime by editing the positioning sketch.



Create Fillets and Chamfers Student book reference: Student Guide: Create Fillets and Chamfers



Talk to the students: Introduce the next step.



What is a Fillet? Student book reference: Student Guide: What is a Fillet?



Talk to the students: A fillet is a curved face of a constant or variable radius that is tangent to, and that joins, two surfaces. Together, these three surfaces form either an inside corner (fillet) or an outside corner (round).
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CATIA V5 Fundamentals Your Notes: Selection and Propagation Modes Student book reference: Student Guide: Selection and Propagation Modes



Talk to the students:



Edge Selection Edges to be filleted can be selected using two different methods: A. Select individual edges. B. Select surfaces – Edges associated with the surface will be filleted (including internal edges). Propagation modes While creating a fillet, you can use two different propagation modes: A. With the Tangency mode, the fillet is applied to the selected edge and all edges tangent to the selected edge. B. With the Minimal mode, the fillet is applied only to the selected edge.



Filleting an Edge Student book reference: Student Guide: Filleting an Edge



Talk to the students: An edge fillet is a constant radius fillet that creates a smooth transitional surface between two adjacent faces. Identify the steps to create an edge fillet. The edges to be filleted can also be pre-selected before accessing the Edge Fillet tool. Review the results. The objects to fillet can be changed at anytime by double-clicking on the fillet from the tree or directly on the model.



Face-Face Fillets (1/2) Student book reference: Student Guide: Face-Face Fillets (1/2)



Talk to the students:



A face-face fillet is used when no intersection exists between the faces, or when more than two sharp edges exist between the faces. Identify the steps to create a face-face fillet. Review the results.
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CATIA V5 Fundamentals Your Notes: Face-Face Fillets (2/2) Student book reference: Student Guide: Face-Face Fillets (2/2)



Talk to the students:



Identify the steps to create a face-face fillet using a spine and hold curve. You must sketch the hold curve on one of the selected faces. The spine controls the normal direction of the fillet cross-section as it sweeps along the edge.



Variable Radius Fillets (1/2) Student book reference: Student Guide: Variable Radius Fillets (1/2)



Talk to the students: A variable radius fillet creates a curved surface defined according to a variable radius. Identify the steps to create a variable radius fillet. Additional points can be created before creating the fillet using the Point tool or during fillet creation by right-clicking in the Points field.



Variable Radius Fillets (2/2) Student book reference: Student Guide: Variable Radius Fillets (2/2)



Talk to the students: Identify the steps to create a variable radius fillet. Variable fillets are named the same as Edge fillets in the specification tree but the icon is different.
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CATIA V5 Fundamentals Your Notes: What is a Chamfer? Student book reference: Student Guide: What is a Chamfer?, Chamfer Dimensioning Mode



Talk to the students:



A chamfer removes or adds a flat section from a selected edge to create a beveled surface between the two original faces common to that edge. Like fillets, chamfers have two types of propagation options: A. With the Tangency mode, the chamfer is applied to the selected edge and all edges tangent to the selected edge. B. With the Minimal mode, the chamfer is applied only to the selected edge. There are two dimensioning schemes available when creating a chamfer: A. For Length1/Angle, the length is the distance along the selected edge to the edge of the bevel. The angle is measure with respect to Length1. B. For Length1/Length2, the lengths are measured along the edges to be chamfered to the edge of the bevel. The Arrow represents the direction of Length1. Click the Reverse option from the Chamfer Definition dialog box to toggle the direction.



Creating a Chamfer Student book reference: Student Guide: Creating a Chamfer



Talk to the students:



Identify the steps to create a chamfer. Like fillets, you can also select a face instead of individual edges. When a face is selected, all edges associated with the face will be chamfered.



Recommendation for Fillets Student book reference: Student Guide: One Fillet for Few Edges (1/2), (2/2)



Talk to the students:



If all edges are grouped into single fillet modification of the value of lower vertical edges cannot be done independently. These edges will have to be de-selected in the original fillet and a new fillet created. If edges are grouped by function the fillet radius for the lower vertical wall can be modified independently of the other fillets. Ideally, you should have one fillet for one function.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Basic Features Creation (Detailed Instructions), Basic Feature Creation (Limited Instructions), Basic Features Creation, Edge and Face-Face Fillets



Show the students: Demonstrate the topics learnt in this lesson, before or after the students work on the exercises. Decide when to do the demonstration based on the class. Show a picture or draw a quick sketch of what you plan to create. As a class, decide on the best base feature. Create a pad, pocket, hole, fillet, and chamfer. Edit several features. Edit an edge fillet, remove edges from the definition and add different ones.



Talk to the students: Present the exercises available. As a class, discuss the steps involved in completing the exercises. Which tools will the students need to use? Inform students where they will be saving the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd Exercise. 3rd and 4th exercises will be done without instruction. Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.



Case Study: Basic Features Student book reference: Student Guide: Case Study: Basic Features



Talk to the students: Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study?



Basic Features Creation (Detailed Instructions): Recap Student book reference: Student Guide: Basic Features Creation (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Try to encourage group discussion on the exercises they have just completed.



Ask the students:



Discuss the different tools used. Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Fundamentals Your Notes: Basic Features Creation (Limited Instructions): Recap Student book reference: Student Guide: Basic Feature Creation (Limited Instructions) : Recap



Talk to the students: Discuss the different tools used.



Ask the students: Which method of hole creation did the students choose? Did they pre-select the references or did they add them after using the positioning sketch? Ask if there are any questions about this exercise, any difficulties?



Basic Features Creation: Recap Student book reference: Student Guide: Basic Features Creation : Recap



Talk to the students: In this exercise the student must use the skills they have developed to determine the best way to create the model. No instruction is provided.



Ask the students: Discuss the different methods that could have been used to create this part. Discuss the different tools used. Did different students use different tools? Ask if there are any questions about this exercise, any difficulties?



Edge and Face-Face Fillets: Recap Student book reference: Student Guide: Edge and Face-Face Fillets: Recap



Talk to the students: In this exercise the students must practice creating Face-Face fillets. No instruction is provided. Students have to determine that a preliminary fillets is needed for Ex3D_A; they will have to choose their own radius value. During this exercise, they will have to discover what happens when they change the distance between the faces to be filleted.



Ask the students:



Ask if there are any questions about this exercise, any difficulties? Ensure there are no other questions before moving on.
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CATIA V5 Fundamentals Your Notes: Case Study: Engine Support Recap Student book reference: Student Guide: Case Study: Engine Support Recap



Talk to the students:



Discuss the objectives of the case study. Review the process used to create the engine support. Ensure the students understand the process used to create the case study before beginning the next lesson.
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CATIA V5 Fundamentals Your Notes:



Lesson 4: Additional Part Features Additional Part Features Student book reference: Student Guide: Additional Part Features



Talk to the students: Introduce the lesson. Present the lesson objectives and topics.



Case Study Student book reference: Student Guide: Case Study: Additional Features, Design Intent (1/2), (2/2)



Talk to the students: Introduce the case study for the lesson. The handle block is part of the Handle Mechanism sub-assembly. Locate where the handle block is in the sub-assembly and where the sub-assembly is in the main assembly. Identify the design intent for this model. 1.The top portion of the model will be created as a shaft, the bottom section will be created as a multi-pad. Although both the bottom and top half could have been constructed in one feature, this was done to demonstrate a variety of feature creation tools. 2. Create the holes on the shaft surface, aligned to a user-defined plane which is created at an angle to the XY plane. Creating the holes on a user-defined plane gives more flexibility in the hole placement as the angle of plane can be changed as required. 3.The shell option will hollow out the model as required. Shelling a model like this is not practical. The shelling operation was added to the case study for demonstration purpose only.



Show the students: Consider opening the drill press assembly in CATIA and locating the handle block.



Show the students:



Consider opening the drill press assembly in CATIA and locating the handle block.



Stages in the Process Student book reference: Student Guide: Stages in the Process



Talk to the students:



Identify the stages in the process.
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CATIA V5 Fundamentals Your Notes: Create Feature Profiles and Axis system Student book reference: Student Guide: Create Feature Profiles and Axis system



Talk to the students:



Introduce the step.



Additional Sketcher Tools Student book reference: Student Guide: Additional Sketcher Tools



Talk to the students: Review the tools that will be discussed in this lesson. Note that in first Sketcher lesson the students were shown how to use the other profile tools, as well as the corner and chamfer tools.



Sketcher Transformation Tools Student book reference: Student Guide: Transformation Tools



Talk to the students: Present the transformation tools. Do not provide great detail on this slide. The next slides will discuss the tools in detail.



Mirror and Symmetry Student book reference: Student Guide: Mirror and Symmetry Options



Talk to the students: Both options, Mirror and Symmetry, allow you to mirror the selected geometry about an axis. The Mirror option retains the original geometry, while the Symmetry option removes it.



COPYRIGHT DASSAULT SYSTEMES



51



CATIA V5 Fundamentals Your Notes: Translation (1/2) Student book reference: Student Guide: Translation (1/2)



Talk to the students:



The Translation tool moves the selected geometry along a translation vector. Identify the steps to translate an object. Step 3: When the Duplication mode is selected, the original geometry is unchanged and a copy of the geometry is created in the new location. You can also create multiple instances, each will be equi-distant from each other. In this example, two instances will be created. Step 4: You may choose to keep all internal constraints, and/or all external constraints. External constraints: Constraints between a selected element and other elements in the sketch. Internal constraints: Constraints on a selected element or between a group of selected elements.



Translation (2/2) Student book reference: Student Guide: Translation (1/2)



Talk to the students:



Identify the steps to translate an object. Step 7: If no distance has been entered (step 6), you can place the selected elements anywhere. If a distance has been applied and OK is selected, you will have to define the direction. The Snap Mode option allows you to enter a value, when you drag the mouse it translates at set increments.



Rotation (1/2) Student book reference: Student Guide: Rotation (1/2)



Talk to the students:



The Rotate tool lets you rotate selected sketched element(s) about a point. Identify the steps to rotate an object. Step 3: When the Duplication mode is selected, the original geometry is unchanged and a copy of the geometry is created in the new location. You can create multiple instances. Each will be equi-distant from each other. In this example, one instance will be created. Step 4: If selected, all internal constraints will be maintained. Internal constraints: Constraints on a selected element or between a group of selected elements.
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CATIA V5 Fundamentals Your Notes: Rotation (2/2) Student book reference: Student Guide: Rotation (2/2)



Talk to the students:



Identify the steps to rotate an object. The Snap Mode option allows you to enter a value, when you drag the mouse it rotates at set increments.



Scale Student book reference: Student Guide: Scale (1/2), (2/2)



Talk to the students: The Scale tool lets you resize the selected sketched element(s). Identify the steps to scale an object: Step 3: When the Duplication mode is selected, the original geometry is unchanged and a copy of the geometry is created in the new location. Step 4: If selected, all constraints will be maintained, but converted into reference dimensions. Reference dimensions can be converted to standard dimenisons by double-clicking on the dimension and clearing the Reference option from the Constraint definition dialog box. The Snap Mode option allows you to enter a value, when you drag the mouse it rotates at set increments.



Offset (1/2) Student book reference: Student Guide: Offset Propagation Modes, Offset (1/2)



Talk to the students: The Offset tool lets you offset one or more sketched elements. Once the Offset tool is selected, three different propagation modes become available from the Sketch Tools toolbar: Identify the steps to Offset: Step 3: ==> No Propagation: only the selected element(s) is offset. ==> Tangent Propagation: the selected element(s) and all elements tangent to it are offset. ==> Point Propagation: the selected element(s) and all elements that form a chain with it are offset. Step 5: Each instance will be equi-distant from each other. In this example, two instances will be created.
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CATIA V5 Fundamentals Your Notes: Offset (2/2) Student book reference: Student Guide: Offset (2/2)



Talk to the students:



Identify the steps to Offset



Show the students: A demonstration of the re-limitation tools is suggested. In an empty part, create simple sketched entities to translate, rotate, scale and offset.



Create Multi-profile Sketch Features Student book reference: Student Guide: Create Multi-profile Sketch Features



Talk to the students: Introduce the step.



Multiple Profiles Student book reference: Student Guide: Multiple Profiles



Talk to the students: Multi-profile sketches are sketches that contain more than one closed profile. This gives the benefit of quickly creating multiple features using only one sketch. Since all the features are created from the same sketch, if the sketch is removed, the corresponding features will also be removed. This method is not recommended if the sketched profiles are complicated because it can be difficult to edit all the individual profiles when they are within one sketch. Do not go into details of the uses. More details are given in the next slides.



Multi-Pads/Pockets (1/2) Student book reference: Student Guide: Multi-Pads/Pockets (1/2)



Talk to the students: Multi-pads and pockets are features that create several pads/pockets in one operation. These tools require a sketch with at least two closed profiles that do not intersect. Consider using these tools as a fast way to create multiple features. Step 2: In this example, Multi-Pad is selected. Step 3: The selected domain is highlighted on the model.
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CATIA V5 Fundamentals Your Notes: Multi-Pads/Pockets (2/2) Student book reference: Student Guide: Multi-Pads/Pockets (2/2)



Talk to the students:



Like standard pads and pockets, multi-pad/pockets can be extruded in two directions. Step 2: In this example, Extrusion domain.1 is the inside profile. Step 3: In this example, only Extrusion domain.1 is extruded in two directions. Review the results in the specification tree.



Solving Ambiguity For Multi-Pads/Pockets Student book reference: Student Guide: Solving Ambiguity for Multi-Pads/Pockets



Talk to the students:



Careful thought should be given while creating the profiles for Multi-Pad/Pocket. The profiles cannot intersect and must form a closed loop, otherwise you will receive a feature definition error. Use the Break tool in the Sketcher workbench to create proper profiles if necessary. For example, two profiles are created within the same sketch. If the shared line between the two profiles was created as one geometric element, the multi-feature will fail. The top profile does not form a closed loop. By breaking the shared line into two separate segments the top profile is now closed. Note in the Multi-Pad dialog box a negative number was entered for the length. Entering a negative value in the Length field will create the pad in the other direction.



Sub-Elements of a sketch (1/2) Student book reference: Student Guide: Sub-Elements of a Sketch (1/2)



Talk to the students: In some situations, you may need to create a feature that only uses one particular profile from a multi-profile sketch and ignores the rest. This is done through the Sub-Elements option. The tool lets you extract only the profile you require from the sketch. Because several features can be based on the same sketch, deleting or modifying the sketch will affect all features associated with it. Identify the steps to use a sub-element.



COPYRIGHT DASSAULT SYSTEMES



55



CATIA V5 Fundamentals Your Notes: Sub-Elements of a sketch (2/2) Student book reference: Student Guide: Sub-Elements of a Sketch (2/2)



Talk to the students:



Identify the steps to use a sub-element of a sketch. Step 4: All entities that are part of the same loop as the selected geometry highlight. Step 6: Notice the Profile field now says “complex”.



Solving Ambiguity for Sub-Elements (1/2) Student book reference: Student Guide: Solving Ambiguity for Sub-Elements (1/2)



Talk to the students:



If you select a multi-profile sketch before selecting the feature tool, an error will be displayed indicating that there is a profile ambiguity. This is because multiple profiles are contained within the sketch and CATIA is unsure how to create the feature. Identify the steps to solve the ambiguity error.



Solving Ambiguity for Sub-Elements (2/2) Student book reference: Student Guide: Solving Ambiguity for Sub-Elements (2/2)



Talk to the students:



Identify the steps to solve the ambiguity error.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Multiple Profile Sketch Features (Detailed Instructions), Sketch Analysis and Pocket (Limited Instructions), Multiple Profile Sketch Features



Talk to the students: Present the exercises available to practice the skills learnt in this part of the lesson. As a class, discuss what all will be required in completing the exercises and which tools they should be using? Inform the students where they will be saving the models and where the required start parts are located. Also, inform them that they will be completing the three exercises on by one (time permitting). Detailed instructions are provided for 1st exercise. High level instructions are provided for 2nd exercise. The final exercise provides no instruction. Tell the students to do the exercises and, if possible, note the time they take to complete them.



Show the students: Demonstrate the topics learnt in this lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. A demonstration of the topics covered should include, creating a sketch using the re-limitation tools and using transformations to alter the sketched geometry. Use the created sketch to create a multi-pad feature. Create a second sketch that includes projected 3D elements and use this sketch to create a feature using only one sub-element of the profile.



Multiple Profile Sketch Features (Detailed Instructions): Recap Student book reference: Student Guide: Multiple Profile Sketch Features (Detailed Instructions)



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Sketch Analysis and Pocket (Limited Instructions): Recap Student book reference: Student Guide: Sketch Analysis and Pocket (Limited Instructions)



Talk to the students:



Discuss the different tools used in this exercise. Discuss the Sketch Analysis tool. Was it helpful in solving the sketch problems?



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Multiple Profile Sketch Features: Recap Student book reference: Student Guide: Multiple Profile Sketch Features



Talk to the students:



Discuss the different tools used in this exercise. Discuss the different methods that could have been used to create the model? What are the advantages and disadvantages of the suggested alternatives?



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties? Ensure there are no quetions about the first two steps and the exercises before moving onto next step.



Create Basic Wireframe Geometry Student book reference: Student Guide: Create Basic Wireframe Geometry



Talk to the students: Introduce the step.
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CATIA V5 Fundamentals Your Notes: Reference Geometry Student book reference: Student Guide: Reference Geometry, Accessing the Reference Elements Toolbar



Talk to the students: Discuss what wireframe geometry is. Discuss what a geometrical set is and why it is different from a PartBody. Wireframe geometry can be used to create additional solid geometry. For example, user-defined planes are often created when no existing sketcher support is available. If the Create a geometricalset option is selected, an empty geometricalset will be created with the new part. If the Enable hybrid design option is cleared, when creating a new part, a geoemtrical set is added to the specification tree when the first wireframe element is created. Determining which option to create your new part with is dependent on how your company organizes and controls its data. If you cannot locate the toolbar, it may be turned off. To turn on the toolbar, click View > Toolbars > Reference Elements (Extended).



Power Input Line Student book reference: Student Guide: Power Input Line, Accessing the Reference Elements Toolbar



Talk to the students: Discuss the power input line and why it is important. You can access many tools by typing the command into the power input line. It is a good way to launch functions when you cannot find the icon. Hover over the icon and look to the left of the power input line to view the command. For example, placing the cursor over the Line icon displays c:Line beside the power input line.



Show the students: Open a session of CATIA and locate the Reference toolbar. It can often be difficult for students to find. This is also a good opportunity to show students how to turn on/off toolbars as needed. Show students how to determine the power input for a tool. Enter c:plane in the power input line to demonstate how to activate the tools.
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CATIA V5 Fundamentals Your Notes: Points Student book reference: Student Guide: Points (1/2), (2/2)



Talk to the students:



Points are used to mark a location on a model. They can be used as a basis for creating additional features. Identify the steps to create a point. Step 2: There are many types of points that can be created. The required fields vary depending on the selected type. In this example a Coordinates point type will be constructed. Step 3: For a coordinate point, the X, Y, and Z distances from the reference point are required.



Lines Student book reference: Student Guide: Lines (1/2), (2/2)



Talk to the students: Lines are created for many purposes, they can be used to define the direction for additional geometry (solid and wireframe), or as an axis for a revolved feature. Identify the steps to create a line. Step 2: There are many types of lines that can be created. The required fields vary depending on the selected type. In this example line, Point-Point type, will be constructed. Step 3: For a Point-Point line, two points are required.



Planes Student book reference: Student Guide: Planes (1/2), (2/2)



Talk to the students:



Planes are used to create a planar reference in a specific location. In the Part Design workbench, they are typically used as sketch supports in areas where there is no existing sketch support. Identify the steps to create a plane. Step 2: There are many types of planes that can be created. The required fields vary depending on the selected type. In this example the Offset from Plane type will be constructed. Step 3: For an Offset from plane type, a planar surface or an existing reference plane is required.
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CATIA V5 Fundamentals Your Notes: Create Shaft and Groove Features Student book reference: Student Guide: Create Shaft and Groove Features



Talk to the students:



Introduce the step.



Creating an Axis Student book reference: Student Guide: Creating an Axis, Dimensioning to an Axis



Talk to the students: An axis can be used as a reference to create revolved features. The sketched profile is revolved about it. An axis can also be used to create symmetrical sketched elements inside the Sketcher workbench. Use the following steps to create an axis: 1.Select the Axis icon. 2.Left mouse click to create the start point for the axis. 3.Left mouse click again to create the end point. 4.Using the shaft command on the profile sketch, CATIA produces a shaft using the axis defined. You can define diameter and radius dimensions to an axis. This is particularly useful when creating the profile sketches for revolved features. To create a Radius/Diameter dimension to an axis, use the following steps: 1.Select the Constraint icon. 2.Select the sketched element. 3.Select the axis. 4.Right mouse click and click Radius/Diameter. 5.Left mouse click to place the dimension.



Revolved Features Student book reference: Student Guide: Revolved Features (1/2), (2/2)



Talk to the students: Discuss the types of revolved features. Revolved features can be revolved between 0° and 360°. You can define limits: ==> The First angle limit defines the revolution angle of the profile around the axis, starting from the profile position and orientated in the clockwise direction ==> The Second angle limit defines the revolution angle of the profile around the axis, starting from the profile position and oriented in the counterclockwise direction.
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CATIA V5 Fundamentals Your Notes: Axis of Revolution Student book reference: Student Guide: Axis of Revolution



Talk to the students:



The axis of revolution for a revolved feature can be defined by two methods. The axis can be created inside the actual sketch containing the profile using the Axis tool. If the axis is created inside the sketch it will be detected automatically, when defining the shaft or groove. If you did not create an axis in the sketch, or want to use a different axis other than the one defined in the sketch, you can define it from the Shaft/Groove definition dialog box in the Axis selection field. Any linear element in the model (e.g., an edge of existing geometry, a 3D wireframe line, a line created in a sketch) can be used.



Shafts Student book reference: Student Guide: Shafts



Talk to the students:



A shaft is a revolved sketched based feature that adds material to the model. Identify the steps to create a shaft. Note that by offsetting the rotation axis away from the profile, the resulting part would be hollow.



Creating Grooves Student book reference: Student Guide: Creating Grooves



Talk to the students: Grooves are revolved features that remove material from existing features by rotating a 2D profile around an axis. The axis and the profile can be created in the same sketch or the axis can reside outside of the sketch. Identify the steps to create a groove. Step 3: In this example, the implicit axis of the cylindrical feature is selected. You can select the implicit axis of the shaft feature as the axis of revolution by placing your cursor over the shaft feautre and holding the key. The axis will be displayed, select it.
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CATIA V5 Fundamentals Your Notes: Restrictions for Revolved Features Student book reference: Student Guide: Restrictions for Revolved Features (1/2), (2/2)



Talk to the students:



Not every sketch can be used to create a shaft base feature. Discuss the examples showing various sketch solutions.



Exercise Overview Student book reference: Student Guide: Shaft and Groove (Detailed Instructions), Shaft and Groove (Limited Instructions), Shaft and Groove



Talk to the students: Present the exercises available to practice creating revolved features and reference geometry. Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd exercise. The final exercise provides no instruction. Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.



Show the students: Demonstrate the topics learnt in this part of lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. A demonstration of the topics covered should include creating various reference elements, and creating shaft and groove features. Demonstrate how to create an axis inside the sketch and how to create a diameter dimension.



Ask the students: As a class, discuss what will be involved in completing the exercises. What tools will they need to use?



Shaft and Groove (Detailed Instructions): Recap Student book reference: Student Guide: Shaft and Groove (Detailed Instructions) : Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.
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CATIA V5 Fundamentals Your Notes: Shaft and Groove (Limited Instructions): Recap Student book reference: Student Guide: Shaft and Groove (Limited Instructions) : Recap



Talk to the students:



Discuss the different tools used in this exercise. Discuss step 3.



Ask the students:



Did everyone use the transormation tools to create the multiprofiles?



Shaft and Groove: Recap Student book reference: Student Guide: Shaft and Groove : Recap



Talk to the students:



Discuss the different tools used in this exercise. Discuss the different methods that could have been used to create the model. Discuss the merits and demerits of the other tools. Discuss the use of reference elements such as points and lines.



Shell the Model Student book reference: Student Guide: Shell the Model



Talk to the students: Introduce the step.



Shelling a Part (1/2) Student book reference: Student Guide: Shelling, Shelling a Part (1/2)



Talk to the students: Shelling a feature hollows out solid geometry. The shelling operation removes one or more faces from the solid and applies a constant thickness to the remaining faces. You can also apply a different thickness to selected faces. Identify the steps to shell an object. The “Outside Thickness” entry adds material to the outside of the part definition.
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CATIA V5 Fundamentals Your Notes: Shelling a Part (2/2) Student book reference: Student Guide: Shelling a Part (2/2), Avoid Shell with Multiple Thickness



Talk to the students: Identify the steps to shell an object. Step 6: Take care to select the dimension associated with the correct direction. To create a shell feature of constant thickness skip steps 4-6. Discuss the results in the specification tree.



Importance of Feature Order Student book reference: Student Guide: Importance of Feature Order



Talk to the students:



While shelling a model it is important to consider feature order. The shell operation will hollow all solid features in a model. If you do not want a feature shelled, it should be created after the shell operation. For example, when a feature containing a hole is shelled, a pipe is created. If a hole was the design intent, the shell feature needs to be created before the hole. You can re-order features without deleting them. The Re-order operation will be discussed later.



Thin Features Student book reference: Student Guide: Thin Features (1/2), (2/2)



Talk to the students: A thin feature is created by applying a constant thickness to a profile. Pads, pockets, shafts, and grooves can all be created as a thin feature. A thin feature can be created with a closed or open profile. The thickness can be applied to one side or both sides of the profile. Identify the steps to create a thin feature. Step3: Thickness 1 defines the inside thickness, Thickness 2 defines the outside thickness. Select the Neutral Fiber option to define thickness symmetrically from the Profile (i.e., Thickness 1 = Thickness 2). Discuss other ways to create this feature. For example, this geometry can also be created using the shell option, but this method requires fewer features.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Thin Pad and Shell (Detailed Instructions), Pad, Fillet, Hole and Shell (Limited Instructions), Thin Pad, Shell and Holes



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first , while some will prefer to work out the exercises and then see the demonstration. A demonstration of the topics covered should include creating a simple feature, adding holes, and shelling the model. Create a second feature using the thick option.



Talk to the students: Present the exercises available to practice creating thin and shelled features. As a class, discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting).



Case Study: Additional Features Student book reference: Student Guide: Case Study: Additional Features



Talk to the students: Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.



Thin Pad and Shell (Detailed Instructions): Recap Student book reference: Student Guide: Thin Pad and Shell (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. Discuss the order of steps 4 and 5.



Ask the students:



Why were the fillets added before the model was shelled, what did this accomplish? Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Pad, Fillet, Hole and Shell (Limited Instructions): Recap Student book reference: Student Guide: Pad, Fillet, Hole and Shell (Limited Instructions): Recap



Talk to the students: Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Thin Pad, Shell and Holes: Recap Student book reference: Student Guide: Thin Pad, Shell and Holes: Recap



Talk to the students:



Discuss the different methods used to create the model. Discuss the different tools used in this exercise. Did all the students use the same tools? Discuss the importance of feature order in creating the model. Introduce the pattern of features as an alternate solution.



Ask the students: Were there are any questions about this exercise, any difficulties?



Case Study: Handle Block Recap Student book reference: Student Guide: Case Study: Handle Block Recap



Talk to the students: Discuss the objectives of the case study. Review the process used to create the handle block.



COPYRIGHT DASSAULT SYSTEMES



67



CATIA V5 Fundamentals Your Notes:



Lesson 5: Dress-up Features Dress-up Features Student book reference: Student guide: Dress-up Features



Talk to the students: Introduce the lesson. Present the lesson objectives and topics.



Case Study Student book reference: Student Guide: Case Study: Dress-up Features, Design Intent



Talk to the students:



Introduce the case study for this lesson. Identify where the casing is located in the main assembly. Identify the design intent for this model. Stiffener features provide the most efficient method of creating this geometry. This part would most likely be manufactured through a molding process, which requires drafts. Taps can be represented simply without needing to create the complex geometry, which can be time consuming and resourceintensive during regeneration cycles.



Stages in the Process Student book reference: Student Guide: Stages in the Process



Talk to the students: Identify the stages in the process.



Apply a Draft Student book reference: Student Guide: Apply a Draft



Talk to the students:



Introduce the first step.
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CATIA V5 Fundamentals Your Notes: What is a Draft? (1/2) Student book reference: Student Guide: What is a Draft? (1/2)



Talk to the students:



Draft features apply an angle to a part surface relative to some reference. Material is added or removed depending on the draft angle and the pulling direction.



What is a Draft? (2/2) Student book reference: Student Guide: What is a Draft? (2/2)



Talk to the students: The pulling direction is defined as the direction from which the draft angle is measured. It is the direction in which sides of a mold are pulled, while extracting a mold. The draft angle is the angle that the draft faces make with the pulling direction with reference to the neutral element. This angle can be defined for each face. The neutral element is used to define the pivot hinge for the drafted surfaces. The drafted surfaces pivot about a neutral curve, the hinge, where it intersects the neutral element. The neutral element, usually a plane or face, can be the same reference used to define the pulling direction. The neutral element is displayed in blue, and the neutral curve is displayed in pink. The faces to be drafted are in dark red. The geometry that is selected as the Neutral Element remains the same during the draft operation (i.e. it is not affected by the draft).



Basic Drafts Student book reference: Student Guide: Basic Drafts (1/2), (2/2)



Talk to the students:



To create a basic draft, you need to define the following: ==> Faces to be drafted ==> Neutral element ==> Pulling direction When you select a reference to be the Neutral Element, CATIA automatically uses the same reference for the Pulling Direction. Identify the steps to create a draft. You can enter a negative value for the draft angle.
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CATIA V5 Fundamentals Your Notes: Reflect Draft (1/2) Student book reference: Student Guide: Reflect Draft (1/2)



Talk to the students:



Drafts can also be applied to surfaces that are not planar, such as cylinders. They can also be created based on the reflect lines generated for a surface in a particular direction. Identify the steps to create a reflect draft.



Reflect Draft (2/2) Student book reference: Student Guide: Reflect Draft (2/2)



Talk to the students: Identify the steps to create a reflect draft.



Variable Draft Student book reference: Student Guide: Variable Draft (1/2), (2/2)



Talk to the students: In certain situations, you may need to create a draft that has different angles at transition edges. This can be accomplished using a variable draft. Identify the steps to create a variable draft. Step 4: The transitions appear on the model and can be edited by double-clicking the dimension.



Selecting Faces to Draft Student book reference: Student Guide: Selecting Faces to Draft



Talk to the students:



When your design intent permits, apply a single draft feature to multiple faces. This reduces the number of features in the specification tree.



Using the Draft Analysis Tool Student book reference: Student Guide: Using the Draft Analysis Tool



Talk to the students:



Identify the steps to create a draft analysis.
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CATIA V5 Fundamentals Your Notes: Create a Stiffener Student book reference: Student Guide: Create a Stiffener



Talk to the students:



Introduce the next step.



Introduction to Stiffeners Student book reference: Student Guide: Introduction to Stiffeners



Talk to the students: Introduce the Stiffener feature. ==> From Side: The sketch is extruded in the profile plane and thickened normal to it. ==> From Top: The sketch is extruded normal to the profile plane and thickened in the profile plane.



Creation of a Stiffener Student book reference: Student Guide: Create a Stiffener (1/2), (2/2), Recommendations for Stiffeners, Avoid Creation of Stiffeners



Talk to the students: The Pad feature can be used to obtain the same result in certain cases. Preferred to stiffeners. A stiffener feature is created from an open line, and the use of closed lines rather than open lines is preferred for the creation of solids. When a stiffener is created, the ends of the open line are projected on to the nearest face of the active body. If this face disappears due to subsequent modifications, then the function will fail with an error message. If the same kind of geometry is created with a pad feature then the result will be visible and the modification to be carried out will be easy to see.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Stiffeners and Draft (Detailed Instructions), Reflect Draft (Limited Instructions), Stiffeners and Draft



Show the students: Demonstrate the topics learned in this lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. The demonstration should include, creating each type of draft feature, and creating a stiffener.



Talk to the students: Present the exercises available. Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd exercise. Third exercise will be done without instruction. Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.



Ask the students: As a class, discuss what will be involved in completing the exercises. What tools will they need to use?



Stiffeners and Draft (Detailed Instructions): Recap Student book reference: Student Guide: Stiffeners and Draft (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Try to encourage group discussion on the exercises they have just completed. Discuss the different tools used.



Ask the students: Were there are any questions about this exercise, any difficulties?



Reflect Draft (Limited Instructions): Recap Student book reference: Student Guide: Reflect Draft (Limited Instructions): Recap



Talk to the students:



Discuss the different tools used. Discuss how the students created the profile in step 5.?



Ask the students:



Did they use the offset tool? What did they offset, the entire top surface or each edge separately Were there are any questions about this exercise, any difficulties?
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CATIA V5 Fundamentals Your Notes: Stiffeners and Draft: Recap Student book reference: Student Guide: Stiffeners and Draft: Recap



Talk to the students:



Discuss the different tools used. Discuss the methods used to create the model.



Ask the students:



Did everyone use the same features in the same order? If not, discuss the positives and negatives of the other methods. Were there are any questions about this exercise, any difficulties?



Create Threads and Taps Student book reference: Student Guide: Create Threads and Taps



Talk to the students: Introduce the next step.



What are Threads and Taps? Student book reference: Student Guide: What are Threads and Taps? (1/2), (2/2)



Talk to the students:



A thread is a helical groove on the outside of a cylindrical shaft, while a tap is a helical groove inside a cylindrical hole. In CATIA, the actual geometry of threads and taps is not displayed. It is represented on the part cosmetically. The features contain parameters that define the intended thread and tap geometry, such as diameter, pitch, and depth. The Thread/Tap Definition dialog box enables you to specify the following: A. The surfaces on which the thread or tap is placed. B. The start surface of the thread or tap. C. The type, which can be Standard or Non standard. CATIA has two pre-defined standards. You may add a customized one, by selecting the Add button. D. Characteristics of the thread/tap may differ depending on the standard that is applied. Keep in mind that the threads and taps will not be shown in CATIA as illustrated above.



Thread and Tap (1/2) Student book reference: Student Guide: Thread and Tap (1/2)



Talk to the students:



Identify the steps to create a thread/tap.
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CATIA V5 Fundamentals Your Notes: Thread and Tap (2/2) Student book reference: Student Guide: Thread and Tap (2/2)



Talk to the students:



Identify the steps to create a thread/tap. During the thread creation, CATIA helps you with the thread parameters in accordance with the selected standard. The thread or tap geometry does not appear on the model, but does in the specification tree. It can also be displayed in a drawing view, as shown.



Exercise Overview Student book reference: Student Guide: Thread and Tap (Detailed Instructions), Thread



Show the students: Demonstrate the topics learned in this part of lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. A demonstration of the topics covered should include, creating a thread/tap feature and forcing a feature failure. Use the methods discussed in the lesson to resolve the failure.



Talk to the students: Present the available exercises. As a class, discuss what will be involved in completing the exercises. What tools will they need to use?



Thread and Tap (Detailed Instructions): Recap Student book reference: Student Guide: Thread and Tap (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Thread: Recap Student book reference: Student Guide: Thread : Recap



Talk to the students:



Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Edit Features Student book reference: Student Guide: Edit Features



Talk to the students: Introduce the next step.



Editing Features Student book reference: Student Guide: Editing Features



Model View Options Student book reference: Student Guide: Model View Options



Talk to the students: Discuss the ways to hide objects in CATIA. Do not go into details, as both these methods will be discussed further in the coming slides.
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CATIA V5 Fundamentals Your Notes: Hide/Show Student book reference: Student Guide: Hide/Show (1/2), (2/2)



Talk to the students:



Wireframe and surface geometry (such as sketches, and reference planes) can be removed from display to help clarify the screen. You can hide/show elements using a number of methods: A. Right-click on the element(s) either in the specification tree or in the model and select the Hide/Show command. B. Highlight the element(s) and select the Hide/Show icon. C. To hide/show all elements of the same type you can also use the Tools > Hide or Tools > Show menu. CATIA has two visual spaces: visible and invisible. Objects that can be seen are in the visible space, whereas hidden objects are in the invisible space. You can determine if an element is in the visible space or the invisible space using any of the following methods: A. The symbols of hidden elements appear blurred in the specification tree B. Select the Swap Space icon. This switches your view to the invisible space. All hidden elements are shown and all shown elements are hidden. To return to visible space, select the Swap Space icon again.



Investigating the Model Student book reference: Student Guide: Investigating the Model (1/2), (2/2)



Talk to the students: The Specification tree: As you create features, the specification tree is populated. Use the specification tree to help determine how a model was made. Features are added to the tree in the order of creation. Children cannot exist in the tree before their parents. For example, the first feature in the specification tree shown is a pad. Move your curser over the pad in the tree to highlight the pad in the model. The specification tree is also useful when making selections. Rather than highlighting features directly on the model (which can sometimes be difficult), you can use the specification tree. Model Scan: Model scan helps you review the creation of a model, one feature at a time. This tool is helpful to review how models made by others where created. To use the Model scan, click Edit > Scan or Define In Work Object. Parent/Child: The parent/child tool displays all the parents and children of a selected feature. This tool is useful to help determine what relationships exist in a model. To use the Parent/Child tool, right mouse click on the feature and click Parent/Children from the right mouse button contextual menu.
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CATIA V5 Fundamentals Your Notes: Parent-Child Relationships Student book reference: Student Guide: Parent-Child Relationships



Talk to the students:



The references that exist between features, either through the process of creation or by association, are called parent-child relationships. To view a feature’s parent-child relationships, select the feature in the specification tree, and click Parents/Children from the right mouse button pop-up menu. The Parents and Children window opens, showing the feature and its references. Features to the left are parents, while features to the right are its children.



Why Reorder Features? Student book reference: Student Guide: Why Reorder Features?



Talk to the students: A hole was created after a mirror operation. Reordering the hole to come before the mirror gives the result shown on the right. To discuss.



Reordering Features (1/2) Student book reference: Student Guide: Reordering Features (1/2)



Talk to the students:



Identify the steps used to reorder a feature.



Reordering Features (2/2) Student book reference: Student Guide: Reordering Features (2/2)



Talk to the students: Identify the steps used to reorder a feature.
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CATIA V5 Fundamentals Your Notes: Limitations on Using Reorder Student book reference: Student Guide: Limitations on using Reorder



Talk to the students:



When a feature is referenced by another during a design, a parentchild relationship is established between the two. This means that the second feature (i.e., the child) is dependant on the first (i.e., the parent) for its definition. In the example, the sketch for the small pocket is constrained to the large pocket. If you attempt to reorder the small pocket before the large pocket, CATIA reminds you that this is not possible. If this feature was reordered, you would receive an update cycle error due to the circular reference.



Define In Work Object (1/2) Student book reference: Student Guide: Define In Work Object (1/2)



Talk to the students:



As shown previously, feature order can greatly affect the outcome of a model. Feature creation is not only dependent (in terms of design intent) on the features created before it, but also on the features created after it. Therefore, it is necessary to sometimes create features at earlier states of the model, instead of where it currently is in the design phase. This is accomplished by defining the correct work object. When a feature is set as the work object, all features that were created after it are ignored and the model is in the state when that particular feature was created initially.



Define In Work Object (2/2) Student book reference: Student Guide: Define In Work Object (2/2)



Talk to the students: The current work object is underlined in the specification tree. In this example, the PartBody is the work object and all features within it are active. By setting the work object to particular features, the model can be captured at various stages of design.



Ask the students:



Discuss the two images on the bottom left. Ask what features would be underlined in the tree to produce these images. The shaft feature is the work object. Only the shaft feature exists because there are no features before it. The hole feature is the work object. The shaft, pocket.1 and hole feature exist but pocket.2 does not.
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CATIA V5 Fundamentals Your Notes: Deactivate/Activate Student book reference: Student Guide: Deactivate/Activate



Talk to the students:



The Deactivate option temporarily removes features from the update of cycle of the model. The feature can be activated again when needed. You can deactivate features by right mouse clicking on the feature in the specification tree or directly on the model and clicking X.Object > Deactivate. When you deactivate a feature, children of that feature must also be deactivated. Children are defined as features that depend on another feature (the parent) to exist. For example, if the pad feature shown is deactivated, the fillet and the hole must also be deactivated. The hole requires the face of the pad to exist, while the fillet requires the edge of the pad to exist.



Resolving Feature Failures (1/4) Student book reference: Student Guide: Resolving Feature Failures (1/4)



Talk to the students: Creating or modifying features can sometimes result in feature failures. The reasons for feature failures are varied; however, they typically involve references being lost because of a modification, or geometry that cannot be generated the way it is currently defined. When a feature fails due to reasons other than the inability to create geometry, an Update Diagnosis window appears that gives information on why the failure has occurred. You have the option of editing the feature that has failed, deactivating it, isolating its references, or deleting it.



Resolving Feature Failures (2/4) Student book reference: Student Guide: Resolving Feature Failures (2/4)



Talk to the students: The part shown requires you to delete the edge fillet because it is no longer necessary, but it is used as a reference for another feature (the hole) that is still required. Identify the steps to resolve a feature.



Resolving Feature Failures (3/4) Student book reference: Student Guide: Resolving Feature Failures (3/4)



Talk to the students: Identify the steps to resolve a feature.
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CATIA V5 Fundamentals Your Notes: Resolving Feature Failures (4/4) Student book reference: Student Guide: Resolving Feature Failures (4/4)



Talk to the students:



Identify the steps to resolve a feature. Step 9: Notice that the hole placement was dimensioned to the edge of the edge fillet. The hole placement reference was also deleted when the edge fillet was deleted.



Properties (1/2) Student book reference: Student Guide: Properties (1/4), (2/4)



Talk to the students: Features can be individually customized in both appearance and function by the Properties menu option. This can be accessed by selecting the feature and clicking Edit > Properties or by accessing the right mouse button contextual menu. The properties of a feature are split into three tabs: ==> Mechanical ==> Feature properties ==> Graphic The Mechanical tab gives you information about the update status of the feature. The Deactivated option is the only one you can set manually. This option suppresses the feature such that it does not get evaluated during regeneration. By setting this, you can also apply this property to impacted elements. The Associate stop update option allows you to stop the update of this feature and show a custom message. This is useful when you are modifying other areas of the part and wish for this feature to update only in certain conditions.



Properties (2/2) Student book reference: Student Guide: Properties (3/4), (4/4)



Talk to the students:



Feature Properties The Feature Properties tab enables you to give the feature a custom name. This tab displays information regarding who created the part, what day it was created, and when it was last modified. Graphic Within the Graphic tab, you can customize the color, thickness, and line type of the various entities of the feature. You can also specify the layer (used to filter out graphics) properties and how the feature behaves with respect to them.
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CATIA V5 Fundamentals Your Notes: Search (1/2) Student book reference: Student Guide: Search (1/4), (2/4)



Talk to the students:



In a complex part with a large quantity of features it can be challenging to locate particular items to edit or modify them. CATIA enables you to search for particular items using a variety of criteria. To access the functionality, click Edit > Search. The General tab enables you to search using one of three methods: ==> Name: Searches the model for the feature. You may also use the asterisk (*) wildcard and set the search to be case sensitive. For example (Connector*) looks for all feature names that begin with “Connector”. ==> Type: Searches the model for a particular feature type associated to particular workbench. For example (Part Design – Pad). ==> Color: Searches the model for items that have a particular color.



Search (2/2) Student book reference: Student Guide: Search (3/4), (4/4)



Talk to the students:



The Advanced tab enables you to use the same searching techniques that are found in the General tab; however, you can combine them into more complex boolean expressions. To create the query shown, select the workbench, type, and attribute. Then select the And icon and select another set of criteria. Also note that it is not mandatory to fill out all three fields; you can create the query using any combination of the fields. The searches conducted within the General and the Advanced tabs can be saved to a favorites list. Once a search is run, the Add Favorites icon is selectable and you have the option of giving it a custom name. Once added, it appears in the main window of the Favorites tab.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Exercise: Features Deactivation (Detailed Instructions), Exercise: Features Activation (Limited Instructions), Exercise: Update Error Management (Limited Instructions)



Show the students: Demonstrate the topics learned in this part of lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. A demonstration of the topics covered should include, creating a thread/tap feature and forcing a feature failure. Use the methods discussed in the lesson to resolve the failure.



Talk to the students: Present the available exercises. As a class, discuss what will be involved in completing the exercises. What tools will they need to use?



Case Study: Basic Features Student book reference: Student Guide: Case Study: Dress-up Features



Talk to the students:



Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting). Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.



Exercise: Features Deactivation (Detailed Instructions): Recap Student book reference: Exercise: Features Deactivation (Detailed Instructions) : Recap



Talk to the students:



Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Exercise: Features Deactivation (Limited Instructions): Recap Student book reference: Exercise: Features Deactivation (Limited Instructions) : Recap



Talk to the students:



Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Update Error Management (Limited Instructions): Recap Student book reference: Student Guide: Update Error Management (Limited Instructions) : Recap



Talk to the students: Discuss the different tools used in this exercise. Discuss why the model failed.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Case Study: Casing Recap Student book reference: Student Guide: Case Study: Casing Recap



Talk to the students: Discuss the objectives of the case study. Review the process used to create the casing. Stress that a threaded hole should be created with a hole feature in most cases.
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CATIA V5 Fundamentals Your Notes:



Lesson 6: Reusing Data Reusing Data Student book reference: Student guide: Reusing Data



Talk to the students: Introduce the lesson. Present the lesson objectives and topics.



Case Study Student book reference: Student Guide: Case Study: Reusing Data, Design Intent



Talk to the students:



Introduce the case study for this lesson. The engine is part of the Bloc Engine sub-assembly. Locate where the engine is in the sub-assembly and where the sub-assembly is in the main assembly. Identify the design intent for this model. 1. Creating and sketching of individual pockets can be avoided. 2. This feature can also be created as a rectangular pattern; however, a user-defined pattern will enable you to customize the hole locations. 3. This is one way of quickly recreating the duplicated features. 4. This is an easy method to retrieve data from a source that is accessible to everyone.



Stages in the Process Student book reference: Student Guide: Stages in the Process



Talk to the students:



Identify the stages in the process.



Duplicate Features Student book reference: Student Guide: Duplicate Features



Talk to the students: Introduce the first step.
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CATIA V5 Fundamentals Your Notes: Introduction to Duplicating Features Student book reference: Student Guide: Introduction to Duplicating Features



Talk to the students:



CATIA allows the creation of various types of features; however, some features occur multiple times in a model. In order to avoid creation of each feature individually, duplication tools are used. Two types are discussed in this lesson: A. Mirror: You can create one half of a symmetrical part, and using the Mirror tool you can duplicate the opposite side. B. Pattern: Patterns enable you to create several identical features from an existing one, and to simultaneously position them on a part.



Mirror Student book reference: Student Guide: Mirror



Talk to the students: While designing parts, it is better to identify areas of symmetry before you start making the model. You can reduce the amount of work needed by building half of the part, then using the Mirror tool to build the other side. You can also mirror individual features. Identify the steps to mirror a feature.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Patterns (Detailed Instructions), Patterns (Limited Instructions), Patterns



Show the students: Demonstrate the topics learned in this lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. The demonstration should include the topics covered in this part of the lesson. Create several demonstration parts to illustrate the various duplication options effectively.



Talk to the students:



Present the exercises available. As a class, discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd exercise. Third exercise will be done without instruction. Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.



Patterns (Detailed Instructions): Recap Student book reference: Student Guide: Patterns (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?



Patterns (Limited Instructions): Recap Student book reference: Student Guide: Patterns (Limited Instructions): Recap



Talk to the students:



Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Fundamentals Your Notes: Patterns: Recap Student book reference: Student Guide: Patterns: Recap



Talk to the students:



Discuss the different tools used in this exercise. Discuss the methods used to create the model. Did everyone use the same features in the same order? If not, discuss the positives and negatives of the other methods.



Ask the students: Ask if there are any questions about this exercise, any difficulties? Ensure there are no questions about the first step or the exercises before starting next step.



Transform a Body Student book reference: Student Guide: Transform a Body



Talk to the students:



Introduce the next step.



Introduction to Transformations Student book reference: Student Guide: Introduction to Transformations



Talk to the students: As you create a model, you may need to occasionally move the features. This is accomplished using transformation features. These features enable you to move a body by translating it along an axis, rotating it round an axis, or moving it symmetrically about a plane. There are four types of transformation features: A. Translate B. Rotate C. Symmetry D. Axis-Axis (not covered)
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CATIA V5 Fundamentals Your Notes: Using Transformations Student book reference: Student Guide: Using Transformation Features



Talk to the students:



Transformations are useful when you have created geometry and you decide that it needs to be moved or rotated into a different position. There are some cases where it is not easy to create geometry in the expected plane. You can create the geometry in a different plane, then rotate or translate it to its required position. Transformations can only be used on either the whole Part Body or an individual Body within the Part.



Translation Student book reference: Student Guide: Translation (1/2), (2/2)



Talk to the students:



The Translation tool allows you to move a body in a linear direction. You may define the translation vector in the following three ways: ==> Direction, distance: Moves the body a distance along a linear direction defined by a reference, such as an edge or a plane. ==> Point to point: Moves the body from one point to another. The relative position of the body with respect to the end point is the same, as it was with respect to the start point. ==> Coordinates: Moves the body with respect to a Cartesian coordinate system. Identify the steps to translate a body. Step 3: For this example, the indicated edge was selected to define the direction.



Rotation Student book reference: Student Guide: Rotation



Talk to the students:



An axis and an angle are required to define a Rotate transformation. Identify the steps to rotate a body. Step 3: The indicated edge was selected as the rotation axis.
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CATIA V5 Fundamentals Your Notes: Symmetry (1/2) Student book reference: Student Guide: Symmetry (1/2)



Talk to the students:



Identify the references that can be used.



Symmetry (2/2) Student book reference: Student Guide: Symmetry (2/2)



Talk to the students: Identify the steps to apply symmetry on a body.



Scaling Student book reference: Student Guide: Scaling



Talk to the students: The Scaling option shrinks or expands an entire body based on a single point as a reference. Identify the steps to create a scaling feature. Step2: You can also resize a body in relation to a face or plane by selecting it instead of a reference point. Note that in contrast to the Translate, Rotate, and Symmetry transformation features which do not modify the geometry (they only affect the location), the Scaling transformation feature scales the geometry using a reference and a ratio.



Differences in Transformations Student book reference: Student Guide: Recommendations for Transformations, Differences in Transformations



Talk to the students: Transforming a body can be done using the transformations tools or using the compass. Using the compass to move items is discussed later. Immediately upon selecting any transformation tool, the Question panel appears. Selecting Yes will proceed to the use of the Transformation as selected. The message in the panel reminds you that you can also transform a body by using the Compass.
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CATIA V5 Fundamentals Your Notes: Scaling the Part to Define Mold “Shrink” Student book reference: Student Guide: Scaling the Part to Define Mold “Shrink”



Talk to the students:



A part gets scaled differently depending on the type of element used as the reference. If a point is used, the scaling is done using the same scaling ratio in all three directions.



Copy-Paste Student book reference: Student Guide: Copy-Paste



Talk to the students: Introduce the next step.



Copy and Paste Data (1/3) Student book reference: Student Guide: Copy and Paste (1/3)



Talk to the students: Features can also be duplicated by copying and pasting them within a part. The pasted feature is identical and completely independent of the original feature. Identify the steps to copy and paste.



Copy and Paste Data (2/3) Student book reference: Student Guide: Copy and Paste (2/3)



Talk to the students:



Identify the steps to copy and paste. Step 6: As mentioned previously, the pasted feature is an exact duplicate of the original feature, including its placement on the model. Therefore, its position needs to be modified.
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CATIA V5 Fundamentals Your Notes: Copy and Paste Data (3/3) Student book reference: Student Guide: Copy and Paste (3/3)



Talk to the students:



Identify the steps to copy and paste. Sketches can be copied and pasted to new sketch support. Copy the sketch then select the new sketch support and click Paste from the right mouse button pop-up menu.



Insert Data From a Catalog Student book reference: Student Guide: Insert Data From a Catalog



Talk to the students: Introduce the next step.



Introduction to Catalogs Student book reference: Student Guide: Introduction to Catalogs (1/2), (2/2)



Talk to the students: Catalogs are sets of features or components that are designed to be used as a library of information. You can retrieve these stored items and avoid having to recreate geometry that is frequently used. A User Feature is a group of features that exist as one entity and when placed in a model, it is represented by a single feature. A Power copy is also a group of features that exist as one entity. However, when placed in a model the original order and state of the features are preserved. This gives better flexibility in terms of modifications after placement of the power copy. PowerCopies and UserFeatures are stored in the part they were created in, but they can also can be saved into a catalog. Instantiating the items can be done from the stored catalog or the part in which the PowerCopy / UserFeature was created.



PowerCopy (1/3) Student book reference: Student Guide: Power Copy (1/3)



Talk to the students: A power copy can consist of a feature or a group of features. It differs from a typical copy because, it allows the user to address references of the copied features while pasting it in a new location. The references are controlled through inputs and parameters. Identify the steps to create a power copy.



COPYRIGHT DASSAULT SYSTEMES



91



CATIA V5 Fundamentals Your Notes: PowerCopy (2/3) Student book reference: Student Guide: Power Copy (2/3)



Talk to the students:



Identify the steps to create a power copy. Step 3: As you select features, they appear on the selected components window. Their respective references determine the inputs that are required to place the power copy. Step 4: Descriptive names can make placing the power copy more intuitive.



PowerCopy (3/3) Student book reference: Student Guide: Power Copy (3/3)



Talk to the students: Identify the steps to create a power copy. Step 5: These are the parameter values that you wish to modify when placing the power copy. To make a parameter variable, select the parameter in the list and select the Published option.



User Feature Student book reference: Student Guide: User Feature



Talk to the students:



The Outputs tab enables you to specify which feature is the main output result of the user feature. You can also add a separate feature to be included along with the main result. The Type tab enables you to assign a particular type to the user feature, so that it behaves like any other type, and can be searched in the specification tree.



Catalog Creation Student book reference: Student Guide: Catalog Creation



Talk to the students:



Once a power copy or user feature is created, it can be stored in the form of a catalog outside the part file, in which it was created. Identify the steps to create a catalog.
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CATIA V5 Fundamentals Your Notes: Inserting Catalog Items (1/2) Student book reference: Student Guide: Inserting Catalog Items (1/3), (2/3)



Talk to the students:



Once a catalog is created, its contents can be inserted into any document as long as the input requirements are met. Identify the steps to insert a catalog item.



Inserting Catalog Items (2/2) Student book reference: Student Guide: Inserting Catalog Items (3/3)



Talk to the students: Identify the steps to insert a catalog item.



Exercise Overview Student book reference: Student Guide: Part Transformation and Catalog (Detailed Instructions), Patterns Modifications (Limited Instructions), Pattern and Catalog



Show the students: Demonstrate the topics learned in this part of lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. A demonstration of the topics covered should include creating either a user feature or a power copy, saving it to a catalog and inserting it into another part file.



Talk to the students:



Present the available exercises. As a class, discuss what will be involved in completing the exercises. What tools will they need to use?
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CATIA V5 Fundamentals Your Notes: Case Study: Reusing Data Student book reference: Student Guide: Case Study: Reusing Data



Talk to the students:



Review the requirements for the case study. Discuss as a class how the model will be completed, what tools are needed to create the case study? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting). Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.



Part Transformation and Catalog (Detailed Instructions): Recap Student book reference: Student Guide: Part Transformation and Catalog (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Patterns Modifications (Limited Instructions): Recap Student book reference: Student Guide: Patterns Modifications (Limited Instructions): Recap



Talk to the students: Discuss the different tools used in this exercise.



Ask the students:



Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Pattern and Catalog: Recap Student book reference: Student Guide: Pattern and Catalog: Recap



Talk to the students:



Discuss the different tools used in this exercise. Discuss the methods used to create the model.



Ask the students:



Did everyone use the same features in the same order? If not, discuss the positives and negatives of the other methods. Ask if there are any questions regarding this exercise? Any difficulties?



Case Study: Engine Recap Student book reference: Student Guide: Case Study: Engine Recap



Talk to the students: Discuss the objectives of the case study. Review the process used to complete the engine.
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Lesson 7: Finalizing Design Intent Finalizing Design Intent Student book reference: Student guide: Finalizing Design Intent



Talk to the students: Introduce the lesson. Present the lesson objectives and topics.



Case Study Student book reference: Student Guide: Case Study: Finalizing Design Intent, Design Intent (1/2), (2/2)



Talk to the students: Introduce the case study for this lesson. The table is part of the stand sub-assembly. Locate where the table is in the sub-assembly and where the subassembly is in the main assembly. Identify the design intent for this model. 1. The material selected for this part is aluminum. The material properties of aluminum in the CATIA library will meet the requirements. 2. Review the model requirements. These requirements can be verified with the measurement tools and enforced using the formulas.



Stages in the Process Student book reference: Student Guide: Stages in the Process



Talk to the students:



Identify the stages in the process.



Apply Material Properties Student book reference: Student Guide: Apply Material Properties



Talk to the students: Introduce the step.
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CATIA V5 Fundamentals Your Notes: Applying Material Properties (1/2) Student book reference: Student Guide: Material Properties, Applying Material Properties (1/2)



Talk to the students: Material can be applied to any part in CATIA. The material properties (e.g., density) then affects the mass properties of the part. CATIA has a default library of materials already installed. Your company may also have custom materials created to conform to your requirements. Identify the steps to apply a material. Step 3: The material applied in this example is Aluminum from the Metal tab. Use the Open Material Library icon, inside the Library dialog box, to browse to other material libraries your company may have.



Applying Material Properties (2/2) Student book reference: Student Guide: Applying Material Properties (2/2)



Talk to the students: Identify the steps to alter the material properties. Modifying the properties of the material will affect the local material properties and this will not affect the other parts referring to this material. Observe other tabs in the Properties dialog box. Use the other tabs to change Rendering characteristics of the material and the crosshatching style in a drawing.



Viewing Material on the Model Student book reference: Student Guide: Viewing Material on the Model



Talk to the students:



Select customized view from View toolbar. The Material rendering characteristic can be changed, using the Rendering tab button in the Properties dialog box.



Measure the Model Student book reference: Student Guide: Measure the Model



Talk to the students: Introduce the next step.
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CATIA V5 Fundamentals Your Notes: Analysis Tools Student book reference: Student Guide: Analysis Tools



Talk to the students:



Several tools are available inside the Part Design workbench to analyze a model. All measurements can be saved in the specification tree by selecting the Keep Measure option. ==> The Measure Between tool is used to measure the distance between elements in a model. ==> The Measure Item tool is used to measure a specific element in a model. ==> The Measure Inertia tool is used to calculate the mass properties of the model.



Element Selection Student book reference: Student Guide: Element Selection (1/2), (2/2)



Talk to the students: When you are selecting elements for measurement, the cursor icon indicates the type of element being selected. The following types of elements may be indicated: a. Cylindrical surface b. Plane or planar surface c. Arc center d. Line e. Point Another way to ensure you are selecting the intended element is to isolate the type of element you want. This is done using the selection mode pull-down menus. This helps to ensure you are selecting the intended element to measure.



Measure Between Modes Student book reference: Student Guide: Measure Between Modes



Talk to the students: Identify the Measure Between tool in the Measure toolbar. Measure between is used to measure between two elements in a model. Discuss the three different modes of measure. A. In Standard Mode, both elements must be selected with each measurement. B. In Fan Mode, measurements are made between the first element selected and each element selected thereafter. C. In Chain Mode, the second element selected for a measurement automatically becomes the first element for the next measurement.
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CATIA V5 Fundamentals Your Notes: Measure Between (1/2) Student book reference: Student Guide: Measure Between (1/2)



Talk to the students:



Identify the steps to measure between elements. Step 2: In this example, Standard Mode is selected. Step 3 & 4: Note the curser in the images. This is indicating what element you are measuring (either the first or the second element in the measurement), as well as the type of element being measured (e.g., line and arc center).



Measure Between (2/2) Student book reference: Student Guide: Measure Between (2/2)



Talk to the students: Identify the steps to measure between elements. Review the results in the specification tree. Make note that the dimension on image 6a will remain displayed if the Keep Measure option is selected. Use Hide/Show to hide the display of saved measurements on the model. Saved measurements can be used in formulas. This will be taught later.



Measure Item (1/2) Student book reference: Student Guide: Measure Item (1/2)



Talk to the students:



The Measure Item tool lets you measure individual geometric elements. Identify the steps to measure an element. Step 2: Note the curser in image 2. This is indicating what element you are measuring (the first), as well as the type of element being measured (e.g., cylinder). Select the Customize… button to calculate properties such as Center of gravity for surfaces and volumes, Direction vector for an edge, etc.



Ask the students: Would the number associated with the cursor every display a 2 when using Measure item? Why not?
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CATIA V5 Fundamentals Your Notes: Measure Item (2/2) Student book reference: Student Guide: Measure Item (2/2)



Talk to the students:



Identify the steps used to measure an element. Review the results in the specification tree. Make note that the measurement displayed on image 6 will remain displayed if the Keep Measure option is selected. Use Hide/Show to hide the display of saved measurements. Note that you can change between the different measurement types inside the Measure dialog box (i.e., Measure between, Measure Item, Thickness)



Components Option Student book reference: Student Guide: Components Option (1/2), (2/2)



Talk to the students: By default, measurements report the shortest distance between two elements. To obtain the component distances (i.e., distances in the X, Y, and Z directions) relative to a coordinate system, select the Customize button and click Components. The component distances are displayed in the Results section. The default X, Y, and Z directions are based on the default axis system for the model. You can choose an alternate axis system using the Other Axis option. The component distances of the measurement are then based on the selected axis. If you want a measurement in a specific direction to display on the model, create a reference plane normal to the measured direction and measure to it. Exercise 7A discusses this method.



Show the students:



You may need to demonstate this concept.



Mass Properties Student book reference: Student Guide: Mass Properties



Talk to the students:



3D properties, which are calculated on surfaces (e.g., feature faces) and volumes (e.g., features and PartBodies). 2D Properties, which are calculated inertia properties on planar 2D surfaces. The results of 3D and 2D inertia calculations can be customized to report the desired results. The Measure Inertia Customization dialog box displays the types of results that can be reported, including mass properties (e.g., volume, mass, and center of gravity).
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CATIA V5 Fundamentals Your Notes: Measure Inertia (1/2) Student book reference: Student Guide: Measure Inertia (1/2)



Talk to the students:



Identify the steps to calculate 3D mass properties.



Measure Inertia (2/2) Student book reference: Student Guide: Measure Inertia (2/2)



Talk to the students: Identify the steps to calculate 3D mass properties. Use Hide/Show to hide the display of saved measurements.



Creating Measurement Geometry Student book reference: Student Guide: Creating Measurement Geometry (1/2), (2/2)



Talk to the students:



All measurement tools have an option to create geometry. Points, lines, and axis systems can be created to illustrate the measurement. By default, the resulting measurement geometry is associative. If the elements referred by the measurement geometry changes, the same will be updated. This can be made non-associative so that the measurement geometry remains static, when changes occur in the model. Identify the steps to create measurement geometry. Make note of the results in the specification tree in the left hand side example.



Update Student book reference: Student Guide: Update



Talk to the students:



When the Keep Measure option is selected, the measurement is added to the model. Though the measurement is associative, it will not update automatically with changes to the model. If a measurement needs to be updated, the measurement icon in the specification tree is displayed with the swirl symbol. Right click on the measurement and click Local Update. To automatically update measurements, apply the Automatic Update option from Tools > Options > Infrastructure > Part Infrastructure > General.



Ask the students: Ensure there are no questions before moving onto the exercises.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Material and Measures (Detailed Instructions), Material and Measures (Limited Instructions)



Show the students: Demonstrate the topics learned in this lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. A demonstration of the topics covered should include applying material to a model and viewing it, taking measurements and saving them to the model, calculating the mass properties of a model, customizing measurements and creating measurement geometry. Make changes to the model that will affect the measurement to show how to update a measurement.



Talk to the students: Present the exercises available to practice applying material and using the measurement tools. As a class, discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete both (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd exercise. Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.



Material and Measures (Detailed Instructions): Recap Student book reference: Student Guide: Material and Measures (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students:



Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Material and Measures (Limited Instructions): Recap Student book reference: Student guide: Material and Measures (Limited Instructions): Recap



Talk to the students: Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Create Formulas and Parameters Student book reference: Student Guide: Create Formulas and Parameters



Talk to the students: Introduce the next step.



Formulas Student book reference: Student guide: Formulas



Talk to the students: All features and elements in CATIA are unique. As features are created, they receive a unique identifier (parameter). Unique identifiers are given to dimensions and constraints also. Additional parameters are created for the material, saved measurements, etc. These parameters can be used to create formulas. Formulas are equations that relate one parameter to another and ensures design intent is maintained. Formulas are stored under the Relations branch of the specification tree. User-defined parameters are stored under the Parameters branch of the tree.



Identifying Parameters Student book reference: Student guide: Identifying Parameters



Talk to the students: Internal identifiers are associated with each parameter in CATIA. It can often be difficult to determine which parameter is required based on its internal identifier. When the Formula window is displayed and a feature is selected the parameters associated with that feature will be displayed in the Formula dialog box. In addition they will be displayed on the model. If you select a parameter from the model the same parameter will get highlight the dialog box and vice versa.
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CATIA V5 Fundamentals Your Notes: Creating User-Defined Parameters Student book reference: Student guide: Creating User-Defined Parameters (1/2), (2/2)



Talk to the students:



User-defined parameters can contain text information such as designer, revision date, etc. They can also contain a variety of numerical values. Parameters can also be equated to dimensions in your model and can be used to drive your design. Identify the steps to create a user-defined parameter. Step 2: To create a parameter to drive dimensions, for example, select the Length type. The Length type uses the units of the model. Real and Integer types are unitless and therefore are better for constants.



Renaming Parameters Student book reference: Student Guide: Renaming Parameters



Talk to the students: It is helpful to give a parameter a meaningful name as this helps both to identify it and understand its function. Parameters can be renamed using the Formula dialog box. It is recommended not to rename a system generated parameter because if renamed then you cannot immediately see in which feature it is used. The system generated parameter name includes the path (e.g. Base\Pad.1\FirstLimit\Length), so the location of the parameter is evident. Limit renaming to user defined parameters. Identify the steps to rename a parameter.



Filters Student book reference: Student guide: Filters



Talk to the students: The Formulas and Formula Editor dialog boxes have filters that can be used to find a specific parameter quickly. In the Formula dialog box, you can filter by Name or Type. In the Formula Editor box, use the Dictionary, Members of Parameters, and Members of All columns to narrow down the search for the correct parameter. If you have renamed your parameters, consider using the Renamed Parameter filter to quickly display only renamed parameters in the model. Use Filters to locate parameters that do not display on the model (e.g., material, mass, etc). Ensure there are no question before moving onto formulas and recommendations.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Parameter and Formula (Detailed Instructions), Parameter and Formula (Limited Instructions), Parameter and Formula



Show the students: Demonstrate the topics learned in this part of lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. A demonstration of the topics covered should include creating user-defined parameters, determining the identifier for a parameter, and creating a formula. Create a formula that equates a dimension to a user-defined parameter, then drive the dimension by changing the user-defined parameter. If possible, demonstrate the importance of units when creating formulas.



Talk to the students: Present the exercises available to practice creating formulas. As a class, discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd exercise. The final exercise provides no instruction.



Case Study: Finalizing Design Intent Student book reference: Student Guide: Case Study: Finalizing Design Intent



Talk to the students:



Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.
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CATIA V5 Fundamentals Your Notes: Parameter and Formula (Detailed Instructions): Recap Student book reference: Student guide: Parameter and Formula (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Parameter and Formula (Limited Instructions): Recap Student book reference: Student guide: Parameter and Formula (Limited Instructions): Recap



Talk to the students: Discuss the different tools used in this exercise. Ensure that everyone is clear as to why the measurement needed to be created before the formula in steps 5 and 6.



Ask the students:



Ask if there are any questions regarding this exercise? Any difficulties?



Parameter and Formula: Recap Student book reference: Student guide: Parameter and Formula: Recap



Talk to the students:



Discuss the different methods used to create the model. Discuss the different tools used in this exercise. Did all the students use the same tools?



Ask the students:



Ask if there are any questions regarding this exercise? Any difficulties?



Case Study: Finalizing Design Intent Recap Student book reference: Student guide: Case Study: Finalizing Design Intent Recap



Talk to the students:



Discuss the objectives of the case study. Review the process used to finalize the table. Ensure the students understand the process used to complete the case study before beginning the next lesson.
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Lesson 8: Assembly Design Assembly Design Student book reference: Student Guide: Assembly Design



Talk to the students: Introduce the lesson. Present the lesson objectives and topics.



Introduction to Assembly Design Student book reference: Student Guide: Introduction to Assembly Design



Talk to the students:



The components used in an assembly can be pre-existing components or components created within the assembly. Like a part, an assembly contains a specification tree. The tree shows the inserted components, and the constraints used to fix the components.



Terminology Student book reference: Student Guide: Terminology



Talk to the students:



Identify the key features of an assembly: A. A document that contains a collection of components. It has the file extension CATProduct. An assembly is also called a product. B Component: A general term for any model added to an assembly. It can be a part or another assembly (sub-assembly). C. Part Number: Identifies the part file used in the assembly. Normally, the part number is same as the file name for the components, at times, it may be different. D. Instances: Each component inserted into an assembly is a separate instance. For example, if the same part is inserted into an assembly twice, they will have the same part number but different instance numbers. No two components in an assembly can have the same instance number. E. Active item: The active item is the item currently being edited. To make an item active, double-click on it. The active item will be highlighted.
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CATIA V5 Fundamentals Your Notes: Case Study Student book reference: Student Guide: Case Study: Assembly Design, Design Intent, Stages in the Process



Talk to the students: Introduce the case study for the lesson. Locate where the handle mechanism is in the main assembly. Identify the design intent for this model. 1. Although fixing the first component is not essential in CATIA, it is good practice to do so. 2. Fully constraining the components ensures no undesired changes occur. 3. Reusing existing components decreases design time. Identify the stages in the process.



Create a New CATProduct Student book reference: Student Guide: Create a New CATProduct



Talk to the students: Introduce the first step.



Defining a New Assembly Document Student book reference: Student Guide: Defining a New Assembly Document



Talk to the students:



Assemblies are created in the Assembly Design workbench. Use one of the following ways to access the Assembly Design workbench: A. Click Start > Mechanical Design > Assembly Design. B. Click File>New and select Product from the New menu. C. Select the New icon and select Product from the New menu. When the Assembly Design workbench is opened a new empty ' Product'is created.
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CATIA V5 Fundamentals Your Notes: Assigning Product Properties Student book reference: Student Guide: Assigning Product Properties



Talk to the students:



Identify the steps used to access the Properties dialog box: 1. Select the assembly name in the specification tree. 2. Right mouse click and click Properties. 3. Enter the part number and all other relevant information describing the assembly. 4. Select OK to close the Properties dialog box.



Ask the students:



Ensure there are no questions before moving onto the next step.



Assemble the Base Component Student book reference: Student Guide: Assemble the Base Component



Talk to the students: Introduce the next step.



Adding Components Student book reference: Student Guide: Adding Components (1/2), (2/2)



Talk to the students: You can add a component to an assembly in one of the three ways: contextual menu, Product Structure toolbar, and the Insert menu. A. Contextual menu: Right mouse click the assembly that will receive the component and use the contextual menu to insert the component. This is the fastest method of inserting a component. B. Product Structure toolbar: Select the assembly in the specification tree and use the icons in the Product Structure toolbar. C. Insert menu: Select the assembly in the specification tree and use the Insert menu.



Inserting an Existing Component (1/2) Student book reference: Student Guide: Inserting an Existing Component (1/2)



Talk to the students: When you add existing parts or assemblies as components, their corresponding files are not copied into the assembly; they are only referenced by the assembly. Identify the steps used to add a component to an assembly.
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CATIA V5 Fundamentals Your Notes: Inserting an Existing Component (2/2) Student book reference: Student Guide: Inserting an Existing Component (2/2)



Talk to the students:



Identify the steps used to add a component to an assembly. You can add more than one component at a time by holding the or key while selecting the files.



Assigning Component Properties (1/2) Student book reference: Student Guide: Assigning Component Properties (1/2)



Talk to the students: Once components are inserted into a product, you can customize their display and their properties. By default, both the part number and instance names are displayed in the specification tree. Identify the steps used to customize the display of the specification tree. Recall: ==> Part Number: Identifies the part file used in the assembly. Typically, the part number is the same as the file name for the component, but it can be different. ==> Instances: Each component inserted into an assembly is a separate instance. For example, if the same part is inserted into an assembly twice, they will have the same part number but different instance numbers. No two components in an assembly can have the same instance number.



Assigning Component Properties (2/2) Student book reference: Student Guide: Assigning Component Properties (2/2)



Talk to the students: The inserted component properties can also be modified. Identify the steps used to modify the properties of a component. Component Properties: Component Property values can vary by component instance. These properties are stored in the parent assembly’s CATProduct file. Product Properties: Product Property values are the same for all instances of the component. When the component is a CATPart or CATProduct, these properties are stored in the CATPart or CATProduct file.



Ask the students: Ensure there are no questions before moving onto the next step.
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CATIA V5 Fundamentals Your Notes: Manipulate the Position of the Component Student book reference: Student Guide: Manipulate the Position of the Component



Talk to the students:



Introduce the next step.



What does the Compass do? Student book reference: Student Guide: What does the Compass do?



Talk to the students: Once components are inserted into the assembly, they can be manipulated by using the compass to pan and rotate the entire assembly, or by freely dragging and rotating components in it. In the example on the left, the entire assembly rotates about the X axis when the compass is selected as shown. The rotation is temporary because it is not stored in the CATPart or CATProduct documents. You are only changing the viewpoint. In the example on the right, a component is freely rotated about the X axis. If this component is not constrained, the new position is stored in the CATProduct documents. Using the compass to drag and rotate components makes it easier to define assembly constraints.



Positioning the Compass to Move a Component Student book reference: Student Guide: Positioning the Compass to Move a Component



Talk to the students:



Before you can move a component using the compass, you must position the compass on the component. Use the following steps to position the compass: 1. Move your cursor over the small red square of the compass. The cursor icon changes. 2. Press and hold the left mouse button to drag the compass. The shape of the compass changes as it moves. 3. If the component can be selected, the compass takes the orientation of the geometric element that is under it. To select the component, release the left mouse button. A green highlighted compass means that a component is selected and that you can move it.
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CATIA V5 Fundamentals Your Notes: Moving a Component Using the Compass Student book reference: Student Guide: Lesson8- Moving a Component Using the Compass (1/2), (2/2)



Talk to the students: Identify the steps used to move a component with the compass. To move a component while respecting the constraints, press and the left mouse button while moving the component. You need not drag the compass over another component to select it for positioning. You may select another component by clicking on it.



Snapping Components Student book reference: Student Guide: Snapping Components



Talk to the students:



Besides using the compass, components can be moved by using the Snap tool. The functionality involves selecting items between components as references to snap one to another. Identify the steps used to snap a component into position.



Fixing a Component in Space (1/2) Student book reference: Student Guide: Fixing a Component in Space (1/2)



Talk to the students: After inserting the base component, it can be left to “float” in space (without constraints), but it is good practice to fix the component. Fixing it will serve as a reference for placing all other components that are assembled later. Components that are fixed in space return to their position when constraints are updated (i.e., regenerated). Use the following steps to fix a component in space: 1. Select the Fix icon from the Constraints toolbar. 2. Select the component in the tree or in geometry. 3. The component is fixed in space. It is better to fix in space one component in each assembly.



Fixing a Component in Space (2/2) Student book reference: Student Guide: Fixing a Component in Space (2/2)



Talk to the students: A fixed in space component cannot be moved. Discuss what the fix in space tool does using the graphics shown.
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CATIA V5 Fundamentals Your Notes: Fixing a Component (1/2) Student book reference: Student Guide: Fixing a Component (1/2)



Talk to the students:



When you start adding constraints to an assembly, you must first have a fixed component, then place other components with regard to the fixed one. If the component is only fixed (i.e., not fixed in space), you can modify its position, and the assembly will remain coherent in term of constraints. Identify the steps used to fix a component.



Fixing a Component (2/2) Student book reference: Student Guide: Fixing a Component (2/2)



Talk to the students: A fixed component can be moved using the compass. Discuss the difference between the Fix and the Fix in Space. Normally Fix in Space option is selected, however there may be occasions when it is not desirable. Often the first component is inserted into the assembly, the compass is used to position it correctly, then it is fixed in space.



Product Structure Reordering (1/2) Student book reference: Student Guide: Can You Reorder a Product Structure?, Product Structure Reordering (1/2)



Talk to the students: The Graph Tree Reordering tool enables you to reorder components in the specification tree. Identify the steps used to reorder components in the specification tree.



Product Structure Reordering (2/2) Student book reference: Student Guide: Lesson8- Product Structure Reordering (2/2)



Talk to the students:



Identify the steps used to reorder components using the Graph Tree Reordering tool.
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CATIA V5 Fundamentals Your Notes: Copy and Paste a Component Student book reference: Student Guide: Copy and Paste a Component



Talk to the students:



An assembly may require more than one instance of a component. The Copy and Paste options provide an easy way to duplicate a component. Identify the steps used to copy and paste a component. Another way to copy and paste a component is to press the key while dragging the component onto the assembly. You can also use windows shortcuts to cut, copy and paste (i.e., + < C > to copy).



Exercise Overview Student book reference: Student Guide: Basic Assembly (Detailed Instructions), Reuse Components (Limited Instructions), Component Positioning



Show the students: Demonstrate the topics learned in this lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. A demonstration of the topics covered should include creating a new assembly, and inserting the first component. Use the compass to position the component then Fix it in space. Use the compass again to move the component and update the assembly to show that it will be repositioned to its fixed in space location. Insert another component and use the Snap tool to position it.



Talk to the students:



Present the exercises available to practice the skills learned in this part of the lesson. As a class, discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd exercise. The final exercise provides no instruction. Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.
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CATIA V5 Fundamentals Your Notes: Basic Assembly (Detailed Instructions): Recap Student book reference: Student Guide: Basic Assembly (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Reuse Components (Limited Instructions): Recap Student book reference: Student Guide: Reuse Components (Limited Instructions): Recap



Talk to the students:



Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Exercise Component Positioning: Recap Student book reference: Student Guide: Component Positioning: Recap



Talk to the students: Discuss the different tools used in this exercise. Ensure the are no quetions about the first three steps and the exercises before moving onto next step.



Ask the students: What method was used to place the second component correctly (snap or the compass?). What method would give a more exact location? Ask if there are any questions regarding this exercise? Any difficulties?



Assemble & Fully Constrain Components Student book reference: Student Guide: Assemble & Fully Constrain Components



Talk to the students: Introduce the next step.
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CATIA V5 Fundamentals Your Notes: Degrees of Freedom Student book reference: Student Guide: Degrees of Freedom



Talk to the students:



When components are first inserted into assembly, they can be translated and rotated in any direction. As constraints are applied to the component, the degrees of freedom decrease. Ideally, zero degrees of freedom should exist for each component in an assembly. Zero degrees of freedom ensures that the design intent is maintained when changes occur in the assembly. If degrees of freedom are left in the assembly, undesired movements may occur between components. To check for degrees of freedom on a component, right mouse click on the component and click x.object > Components Degrees of Freedom from the contextual menu. Any degrees of freedom remaining will appear in the Degrees of Freedom Analysis window.



Setting Assembly Constraints Student book reference: Student Guide: Setting Assembly Constraints



Talk to the students:



Degrees of freedom are removed from a component by adding constraints. Similar to sketching constraints, the assembly constraints also locate geometry relative to existing features. (in the case of an assembly, existing components). Constraints are added to the assembly using the following methods: A. Constraints toolbar B. Insert menu



Assembly Constraints Student book reference: Student Guide: Assembly Constraints, Available Constraints and their Symbols



Talk to the students: Outline the general steps to add constraints. Updating the assembly is only necessary if the Manual Update option is selected in the assembly settings. It is recommended to update assemblies manually. You have a table of available symbols showing the Symbol used in the Geometry Area, and the Symbol as displayed in the Specification Tree. The types of constraints will be discussed in the next slides.
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CATIA V5 Fundamentals Your Notes: Defining a Coincidence Constraint (1/2) Student book reference: Student Guide: Defining a Coincidence Constraint (1/2)



Talk to the students:



The Coincidence constraint creates an alignment that can be coaxial, coplanar, or merged points. Identify the steps used to apply a coincidence constraint.



Creating a Coincidence Constraint (2/2) Student book reference: Student Guide: Creating a Coincidence Constraint (2/2)



Talk to the students: If the alignment is to make two surfaces coplanar, CATIA gives a choice of orientation with two green arrows. Identify the steps used to define orientation. While placing a constraint between two components, the first component selected will snap to the second component selected. If the first component is already fixed or fixed in space, then the second component will snap to the fixed component.



Defining a Contact Constraint Student book reference: Student Guide: Defining a Contact Constraint



Talk to the students: The Contact constraint connects two planes or faces. Identify the steps to apply a contact constraint.



Defining an Offset Constraint Student book reference: Student Guide: Defining an Offset Constraint



Talk to the students: The Offset constraint defines the distance between two elements. Identify the steps to apply an offset constraint. A. Offset constraint with same orientation B. Offset constraint with opposite orientation



COPYRIGHT DASSAULT SYSTEMES



117



CATIA V5 Fundamentals Your Notes: Creating an Angle Constraint (1/2) Student book reference: Student Guide: Creating an Angle Constraint (1/2)



Talk to the students:



The Angle constraint enables you to define an angle between components. Identify the steps to apply an angle constraint.



Creating an Angle Constraint (2/2) Student book reference: Student Guide: Creating an Angle Constraint (2/2)



Talk to the students: You can also define parallelism or perpendicularity between two elements using the Angle constraint. In the case of parallelism, you can choose between same or opposite orientation. Identify the steps used to apply a parallelism or perpendicularity constraint. A. Parallelism constraint with same orientation B. Parallelism constraint with opposite orientation The Parallelism constraint is different from the Offset constraint because, it does not require a distance value. It is used to orient the components.



Fixing Together Components Student book reference: Student Guide: Fixing Together Components



Talk to the students: The Fix together constraint enables you to constrain components so that, they move as a single entity. It is a good idea to Fix Together unconstrained components to avoid unintentional modification or displacement. Identify the steps used to fix together components. The Fix together constraint is used to glue components together; however, it is possible to unintentionally separate fixed together components with the compass. Use the following steps to configure fixed together components: 1. Click Tools > Options. 2. Select the Assembly Design branch under the Mechanical Design node. In the General tab, select an option to configure fixed together components. You have the following choices: ==> Select Always to move all fixed together components. ==> Select Never to move only the selected component. ==> Select Ask each time to display a warning that prompts you for the desired action.
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CATIA V5 Fundamentals Your Notes: Constraint Rules Student book reference: Student Guide: Recommendation for Constraints (1/2, (2/2), Constraint Rules



Talk to the students: During a product lifecycle parts will be modified or replaced by new versions. There is therefore a risk that geometry will no longer exist after a modification. If parts are positioned with constraints that are based on part geometry then they risk being invalidated and positioning lost. In order to avoid this and to get parts that are correctly positioned even if replaced by a new version, the part can be positioned using constraints between the axis system of the parts of the assembly (each part being designed in its own local axis system rather than in the global vehicle axis system).



Assembly Assistant Student book reference: Student Guide: Assembly Assistant



Talk to the students: The assembly assistant displays a warning if you make mistakes while defining constraints. Warnings may appear in the following cases: A. You try to constrain a component that does not belong to the active product. B. You try to constrain two elements that belong to the same component.



Updating Constraints Student book reference: Student Guide: Updating Constraints (1/2), (2/2)



Talk to the students: It is better to update an assembly before saving it. This will improve performance while opening the assemblies. It is also a good idea to update sub-assemblies before activating another assembly. This avoids unintended results while updating constraints. When you update an assembly, CATIA re-apply all the constraints to the components. You can choose between updating the whole assembly or specific components. Constraints that require updating are indicated in the specification tree and on the model. The example shown has a constraint that needs updating: The icon constraint in the specification tree is not up to date (note the small update symbol on it).
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CATIA V5 Fundamentals Your Notes: Options For Updating Assembly Constraints Student book reference: Student Guide: Options For Updating Assembly Constraints



Talk to the students:



You can have the assembly update automatically or manually. Manual requires you to use the Update tool. It is recommended to set the Manual update option. Automatic mode will modify your assembly with each constraint creation.



Handling Update Errors Student book reference: Student Guide: Handling Update Errors



Talk to the students: When you update an assembly, constraints are checked for conflicts. CATIA will display the Diagnosis window if problems occur (e.g., over constrained components). You can select a conflict from the Update Diagnosis window and do one of the following: A. Select Edit to display the Constraint Definition window. The constraint can be edited or reconnected to a different element. B. Select Deactivate to turn off a constraint without deleting it. This allows you to re-examine the problem later. C. Select Isolate to remove references of the feature to other geometry. D. Select Delete to remove the conflicting constraint completely.



Ask the students:



Ensure there are no questions before moving onto the next step.



Save the Assembly Student book reference: Student Guide: Save the Assembly



Talk to the students:



Introduce the next step.



COPYRIGHT DASSAULT SYSTEMES



120



CATIA V5 Fundamentals Your Notes: Saving an Assembly Document Student book reference: Student Guide: Saving an Assembly Document



Talk to the students:



The following four options (found in the File menu) can be used to save assembly and child documents: A. The Save option saves the active component children of the active document. B. The Save As option is similar to Save, except you can also specify a name and folder for the active document. C. The Save All option saves all the open documents that have been modified since the last save. D. The Save Management option prompts you to save all open documents and children of these documents; however, you can control their names and locations. With each of these options, only the modified documents are saved.



Saving a Document With Another Name Student book reference: Student Guide: Saving a Document With Another Name



Talk to the students: Identify the steps used to save a document using the Save As option. Regenerating Internal Identifiers will avoid instantiation conflicts with the reference. The Save As option enables you to specify a file name and folder to save the file. You can create a new document with new internal identifiers.



Saving All Modified Documents Student book reference: Student Guide: Saving All Modified Documents



Talk to the students:



Identify the steps used to save a document using the Save All option. The Save All option provides an easy way to save all modified documents that are not new nor read-only documents. All modified open documents are saved, regardless of which document is active.
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CATIA V5 Fundamentals Your Notes: What is Save Management? Student book reference: Student Guide: Save Management



Talk to the students:



The Save Management tool is useful when saving assemblies. Discuss how to use ths tool.



Exercise Overview Student book reference: Student Guide: Constrain Components (Detailed Instructions), Constraints Creation (Limited Instructions), Degrees of Freedom



Show the students: Demonstrate the topics learned in this part of lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. A demonstration of the topics covered should include creating an assembly and fully constraining all components in it. Use as many of the constraint tools as possible. Move a fully constrained component using the compass and update the assembly.



Talk to the students: Present the exercises available to practice creating revolved features and reference geometry. As a class, discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd exercise. The final exercise provides no instruction.



Case Study: Assembly Design Student book reference: Student Guide: Case Study: Assembly Design



Talk to the students: Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study?
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CATIA V5 Fundamentals Your Notes: Constrain Components (Detailed Instructions): Recap Student book reference: Student Guide: Constrain Components (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Constraints Creation (Limited Instructions): Recap Talk to the students: Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Degrees of Freedom: Recap Student book reference: Student Guide: Degrees of Freedom: Recap



Talk to the students: Discuss what constraints were needed to fully constrain this assembly. 1. Brace has a rotation degree of freedom about the z axis. It requires an Angle or Coincidence constraint. 2. Pulley_Support has translational degrees of freedom in the x and y directions. It requires a Coincidence constraint along the z axis. Discuss the tool used (x.object > Component Degree of Freedom) to ensure all components are fully constrained.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Case Study: Handle Mechanism Recap Student book reference: Student Guide: Case Study: Handle Mechanism Recap



Talk to the students:



Discuss the objectives of the case study. Review the process used to assemble the handle mechanism. Ensure the students understand the process used to complete the case study before beginning the next lesson.



Ask the students:



What method did the students choose to assembly the second handle (copy/paste, multi instance tool or the re-use pattern). Discuss the positives and the negatives of each of the tools. Discuss the use of Reference planes to define constraints.
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CATIA V5 Fundamentals Your Notes:



Lesson 9: Designing in Context Working in the Context of an Assembly Student book reference: Student Guide: Working in the Context of an Assembly



Talk to the students: For example: ==> Sketches can be supported by the planar face of a neighboring component. ==> Sketch constraints can be defined using elements in other components. ==> 3D elements from other components can be projected onto and intersected with the sketch support. ==> Features can be limited up to other components. Assemblies are often created using a combination of components, that are created separately from the assembly and components created within the context of an assembly. It can be difficult to understand references while designing in context. Hence, it is often considered a more advanced method of creating a component.



Case Study Student book reference: Student Guide: Case Study: Designing in Context, Design Intent, Stages in the Process



Talk to the students: Introduce the case study for the lesson. The chuck is part of the drill support sub-assembly. Locate where the chuck is in the sub-assembly and where the subassembly is in the main assembly. Identify the design intent for this model. 1. This ensures, changes that are made to referenced components are reflected automatically in the chuck. 2. This allows the base feature to move according to the reference plane position of the other model. 3. By creating the axis coincident with the base component, any positional changes to the base component will update in the chuck component. This means the relative position between the two components will remain unchanged. 4. You will create an assembly-level remove feature to define the pocket into which the canella_axis fits; as a result, design intent will be maintained between the two components when modifications are applied. Identify the stages in the process.
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CATIA V5 Fundamentals Your Notes: Open an Existing Assembly Student book reference: Student Guide: Open an Existing Assembly



Talk to the students:



Introduce the step.



Opening an Existing Assembly Student book reference: Student Guide: Opening an Existing Assembly



Talk to the students: Assemblies can contain components that reference individual part and assembly files. These reference parts and assemblies can reside in the same location (e.g., a directory in a file-based data structure) as the top-level assembly, or in different locations. If referenced files are moved from their original locations, CATIA may not be able to locate them when the top-level assembly is retrieved. You should therefore, carefully consider file locations while assembling components and retrieving files. Assemblies can also contain components that only exist within the assembly. These components do not reference outside part or assembly files.



Desk Option (1/2) Student book reference: Student Guide: Desk Option (1/2)



Talk to the students: When an assembly is saved, the locations of all referenced files are written to the product file. If referenced files are moved, CATIA prompts you for the new location of the missing files when the assembly is re-opened. Using the Desk command, you can locate these files. Identify the steps to locate a missing file.



Desk Option (2/2) Student book reference: Student Guide: Desk Option (2/2)



Talk to the students: Identify the steps to locate a missing file.
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CATIA V5 Fundamentals Your Notes: Visualization Mode (1/2) Student book reference: Student Guide: Design and Visualization Mode , Visualization Mode (1/2)



Talk to the students: By default, the assemblies and their components load into a CATIA session in Design mode. In this mode, the part definition (exact geometry and parameters) of all components are loaded into memory. The loading time may be considerable, depending on the size of the assembly. To improve performance, assemblies can be loaded in visualization mode, where CGR representations of the geometry are loaded instead of the actual geometry. CGR (.cgr) files contain no geometry or part information; they are only a tessellated visual representation of the model. Using CGR files, larger assemblies can be loaded much faster. CGR files are created the first time an assembly is loaded with the cache setting turned on. Identify the steps used to activate the cache system. Once the cache system option is selected, all product files will automatically load in visualization mode. The first time an assembly is opened in this mode a CGR file is created for all assembly components. These CGR files are saved in a local directory and are reused the next time the assembly is opened. Setting this option does not affect the retrieval of invidividual part files within the Part Design Workbench.



Visualization Mode (2/2) Student book reference: Student Guide: Visualization Mode (2/2)



Talk to the students:



Other cache system options include the following: A. The Path to the local cache field defines the directory in which the CGR files are stored. B. Released cache are read-only areas where CATIA searches for existing CGR files. These are defined in the Path to the released cache field. C. The Cache Size section defines the maximum cache size. Once the limit is reached, CGR files are deleted based on a first-in firstout rule. D. The Timestamp section saves CGR files with a timestamp and checks whether the model has been modified since the last CGR file creation. If so, it updates with the latest version. GMT timestamp format is used only when a global time scale is required.
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CATIA V5 Fundamentals Your Notes: Working in Visualization Mode Student book reference: Student Guide: Working in Visualization Mode (1/2), (2/2)



Talk to the students:



In Visualization mode, the parts do not contain any technical information. In the specification tree, the individual nodes for components do not appear. Moving your cursor over components, you will notice that the model is tessellated. You cannot highlight individual features. A component must be in Design mode to edit component geometry. Models in Visualization mode cannot be edited. Doubleclick on the particular component to access Design mode and CATIA will load the geometry into session. To return to Visualization mode, right mouse click on the component and click Representations > Visualization mode. You can return that component to Visualization mode only if no changes have been made. If changes have been made, a new CGR file needs to be created. You will need to save and reopen the entire assembly.



Ask the students: Ensure there are no questions before moving onto the exercises.



Exercise Overview Student book reference: Student Guide: Visualization and Design Modes (Detailed Instructions), Visualization and Design Modes (Limited Instructions)



Show the students: Demonstrate the topics learned in this lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. A demonstration of the topics covered should include opening an assembly with missing part files (you will need to prepare this before hand). Locate the missing files using the desk command. Add new components to the assembly.



Talk to the students: Present the exercises available to practice the skills learned in this part of the lesson. As a class, discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete both exercises (time permitting). Detailed instruction is provided for 1st exercise. High level instruction is provided for 2nd exercise. Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.
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CATIA V5 Fundamentals Your Notes: Visualization and Design Modes: Recap Student book reference: Student Guide: Visualization and Design Modes (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Visualization and Design Modes: Recap Student book reference: Student Guide: Visualization and Design Modes (Detailed Instructions): Recap



Talk to the students: Discuss the different tools used in this exercise.



Ask the students:



Ask if the modified part could be returned to Visualization mode? Why not? What needs to be done first to have the modified components return to Visulization mode? Ask if there are any questions regarding this exercise? Any difficulties?



Insert a New Model Student book reference: Student Guide: Insert a New Model



Talk to the students: Introduce the step.
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CATIA V5 Fundamentals Your Notes: Inserting a New Part Student book reference: Student Guide: Inserting a New Model, Inserting a New Part (1/2), (2/2)



Talk to the students: As mentioned in the previous lessons, CATIA enables you to insert previously created components into an assembly. New models can also be created directly in an assembly. The functionality can be accessed through the Insert menu. You can create the following types of models: A. Part: Create a new part file that exists as a separate file. B. Product: Create a new product or sub-assembly that exists as a separate file. C. Component: Create a new product that exists only in the toplevel assembly. Identify the steps used to create a new part file. Step 3: Select Yes to define an origin of the new part in a different location from the origin of the assembly. Select a point or a component to define the origin of the new part. If you select a component, the origin point of the new part will be in the same location as the origin of the selected component. If you select a point, the origin of the new part will be located at this point. Select No to define the origin of the new part in the same location as the origin of the assembly.



Inserting a New Product Student book reference: Student Guide: Inserting a New Product



Talk to the students: New assemblies (CATProducts) can also be inserted in a product. The New Product option will create a new sub-assembly as well as a new external CATProduct file. Identify the steps to create a new product file. The blank sheet behind the component icon in the specification tree means, the component is linked to an external file (here CATProduct type file). A new product can be inserted through the Product icon on the Product Structure Tool toolbar.
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CATIA V5 Fundamentals Your Notes: Inserting a New Component Student book reference: Student Guide: Inserting a New Component



Talk to the students:



You can create a special type of component that exists only in the parent CATProduct and does not have its own file. This product is used in situations where references or configurations of other components are only relevant in the Assembly mode, and do not require a separate CATProduct. Identify the steps to add a new component. There is no blank sheet behind the component icon in the specification tree because, there is no link to an external file. The new component exists only in the parent CATProduct and that does not have its own file. You can insert parts and products into the new component. Inserting a new component can also be achieved through the Component icon on the Product Structure Tool toolbar.



Component Properties Revisited Student book reference: Student Guide: Component Properties Revisited



Talk to the students: New models created in an assembly can be assigned properties. Right mouse click on the component and click Properties to access the properties dialog box. Recall from previous lesson: A. Part Number: Identifies the part file used in the assembly. The part number is same as the file name for the component, but it can be different. B. Instance Name: Each component inserted into an assembly is a separate instance. For example, if the same part is inserted into an assembly twice, they will have the same part number but different instance numbers. No two components in an assembly can have the same instance number.



Ask the students: Ensure there are no questions before moving onto the next step.



Create a Sketch in Context Student book reference: Student Guide: Create a Sketch in Context



Talk to the students:



Introduce the step.
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CATIA V5 Fundamentals Your Notes: Editing a Part Student book reference: Student Guide: Editing a Part



Talk to the students:



To create features in a part within an assembly, you first need to edit the part where these features are to be created. This is accomplished by activating the part (i.e., making it the active object). Once the part is active, CATIA switches to the workbench the part was last edited in or the Part Design workbench. Identify the steps used to activate a part.



Sketching On a Face Of a Component Student book reference: Student Guide: Sketching On a Face Of a Component



Talk to the students: Once a part is active, the interface and functionality are the same as if you were editing a stand-alone part. You can use reference planes and planar surfaces from other components for sketch supports, because the part is now being edited in the context of the assembly. Identify the steps used to access the Sketcher workbench in the context of an assembly.



Projecting or Intersecting 3D Elements Student book reference: Student Guide: Projecting 3D Elements Onto the Sketch Plane, Intersecting 3D Elements with the Sketch Plane



Talk to the students:



Identify the steps to project 3D elements from other components. Discuss the results. Notice that any references from other components are copied into a geometrical set. You can also project other types of elements such as points and faces (which projects the edges of the face). The new component can be inserted in an another assembly, or moved to another position. However, before relocating the component, isolate the intersected element using the contextual menu.



Defining Sketch Constraints Using Other Components Talk to the students: Notice that a copy of the geometric elements from the other part appears in the geometrical set of the active part.
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CATIA V5 Fundamentals Your Notes: Limiting Features Up to Other Components Student book reference: Student Guide: Limiting Features Up to Other Components



Talk to the students:



You can select geometric elements on components for uses other than sketched entity definition. They can be used to specify design features of your part, such as a limit for a pad. Identify the steps needed to define a surface or plane from another component as a limiting element.



References and Options Student book reference: Student Guide: References and Options (1/2), (2/2)



Talk to the students:



While designing in context, external references occur between the part being designed and other components in the assembly. Identify the ways in which external references are created. External references can complicate how a model is updated and modified in the future. You can limit their use to conform to company design standards using options from the menu bar. Click Tools > Options > Infrastructure > Part Infrastructure. The indicated options on the General tab are described below. A. References between the source and target part are maintained. Updates to the source part translate to the target part. B. Displays the external references that are created in the specification tree. C. Prompts you when an external reference is being created. D. Allows you to place the external reference with respect to the root context of the assembly, instead of the most direct context. E. Allows external references to occur only based on elements that have been marked as published. F. Searches to make sure that any target part is updated with the most recent information from the source part. Published elements are features that are ear-marked to be used as references for other feature creation or information.
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CATIA V5 Fundamentals Your Notes: Isolating Features Student book reference: Student Guide: Isolating Features



Talk to the students:



As a general rule when designing in context, the component created within the context of an assembly is unique to the assembly and should not be inserted into another assembly nor moved to another position. However, if your design requires the component be moved, you must break the external references. This is done by isolating the feature. Identify how to isolate features. Once the feature has been isolated it behaves as a regular independent feature which can be modified normally.



Ask the students: Ensure there are no questions before moving onto the next step.



Create Assembly-Level Features Student book reference: Student Guide: Create Assembly-Level Features



Talk to the students: Introduce the step.



What are Assembly Features? Student book reference: Student Guide: What are Assembly Features?



Talk to the students:



Assembly features are features that are applied not only to a single part (from within the part design workbench) but to a set of several parts of an assembly. Split: This operation splits one or more parts with the splitting surface with a single feature. Hole: This operation creates a hole passing through multiple parts with a single feature. Pocket: This operation creates pockets in multiple parts in a single instance. Add: This operation adds a part body to multiple parts in a single instance. The light blue part body is added to the two components. Remove: This operation removes material from all affected parts using the geometry of a part body with a single feature. The light blue part body is removed from to the two components.
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CATIA V5 Fundamentals Your Notes: What are Affected Parts? Student book reference: Student Guide: What are Affected Parts?, Specifying Affected Parts



Talk to the students: Identify the changes in the specification tree.



Specifying Affected Parts Student book reference: Student Guide: Specifying Affected Parts



Talk to the students:



Identify the main steps. Select multiple items using the or keys.



Creating an Assembly Split Student book reference: Student Guide: Creating an Assembly Split



Talk to the students: Identify the main steps.



Creating an Assembly Hole Student book reference: Student Guide: Creating an Assembly Hole, Using Hole Series



Talk to the students:



Identify the main steps. From the Assembly Features Definition dialog box, select the Add Series button. A new tab named Series 1 is created. Select the parts that should be affected by the new hole specification and then select the Select button. Define the new hole specification using the Hole Definition dialog box. Add additional series as desired by repeating steps 1 through 3. Select OK to confirm when finished. The assembly hole will be added into the specification tree along with each series that was added. The feature can be modified from the assembly design workbench.
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CATIA V5 Fundamentals Your Notes: Creating an Assembly Pocket Student book reference: Student Guide: Creating an Assembly Pocket



Talk to the students:



Identify the main steps.



Adding and Removing Bodies Student book reference: Student Guide: Adding and Removing Bodies



Talk to the students: The Add tool will add a body from a part to the affected parts. The body to be added can belong to one of the assembly components on which the add is being applied. The Remove tool will remove the space occupied by a body from the affected parts. The body being removed can belong to one of the assembly components on which the remove is being applied and it can include an entire part body. Identify the main steps Step 4. A linked copy of the body is added to each affected part. Hide all the components except for one of the affected parts and the added body can be seen. Step 4. A linked copy of the body is removed from each affected part. Hide all the components except for one of the affected parts and the added body can be seen.



Cautions About Designing in Context Student book reference: Student Guide: Cautions About Designing in Context



Talk to the students:



h: Discuss the cautions about designing in context. It is important that the students understand that external references are complicated and should only be created if they fully understand what is happening.
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Design in Context (Detailed Instructions), Design in Context (Limited Instructions), Design in Context



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. A demonstration of the topics covered should include creating a feature inside a part using references from other components and creating an assembly level feature.



Talk to the students: Present the exercises available to practice the skills learned in this part of the lesson. As a class discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting).



Case Study: Designing in Context Student book reference: Student Guide: Case Study: Designing in Context



Talk to the students: Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Tell the students to start the exercises and note the time. Assist the students to perform the exercises as and when needed.



Design in Context (Detailed Instructions): Recap Student book reference: Student Guide: Design in Context (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Design in Context (Limited Instructions): Recap Student book reference: Student Guide: Design in Context (Limited Instructions): Recap



Talk to the students:



Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Design in Context: Recap Student book reference: Student Guide: Design in Context: Recap



Talk to the students:



As a group discuss the answers to the questions ask in the exercise: 1. With Bloc_Engine.CATProduct, the only references that exist between the components are through assembly constraints, which cannot modify actual geometry. 2. You are able to move components in both assemblies; however, you will be breaking the assembly constraints in the Bloc_Engine.CATProduct. The components need to be isolated before they can be moved. 3. In Ex9E.CATProduct the engine support will lose references that were used to create its geometry. The part will open, but features that reference the engine will not be modifiable.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?



Case Study: Chuck Recap Student book reference: Student Guide: Case Study: Chuck Recap



Talk to the students:



Discuss the objectives of the case study. Review the process used to create the chuck. Ensure the students understand the process used to create the case study before beginning the next lesson.
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CATIA V5 Fundamentals Your Notes:



Lesson 10: Drafting (ANSI) Case Study Student book reference: Student Guide: Case Study: Drafting, Design Intent, Stages in the Process



Talk to the students: Introduce the case study for the lesson. The base is part of the stand sub-assembly. Locate where the base is in the sub-assembly and where the subassemlby is in the main assembly. Identify the design intent for this model. 1. Standards are predefined formats for dimensions, annotations, and views, which provide a consistent interpretation of information. 2. The display of these items in a single view enables a better understanding of the model by showing depth and internal features. 3.This is typically required with any drawing. Identify the stages in the process.



General Process Student book reference: Student Guide: General Process



Talk to the students: The creation of a drawing for parts and assemblies can begin at any time in the design process. CATIA maintains an associative link between a drawing and the parts and assemblies it references. As the 3D part and assembly models evolve, the drawings automatically show the updated geometry.



Accessing the Workbench Student book reference: Student Guide: Accessing the Workbench



Talk to the students:



The drawings of parts and assemblies are created in CATIA using the Drafting workbench. It can be accessed in the following three ways: A. Start menu B. File menu C. New icon D. Workbench icon
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CATIA V5 Fundamentals Your Notes: The Drawing Environment Student book reference: Student Guide: The Drawing Environment



Talk to the students:



The drawing environment, accessed through the Drafting workbench, consists of the following components: A. Specification tree: Contains sheet and view information. B. Sheet: Contains the drawing views, title block, annotations, dimensions, etc. The active view is underlined in the tree and enclosed in a red frame. C. Prompt: Displays instructions and requirements for tools as they are activated. Command line entries are also made here. D. Toolbars: Contains the Drafting workbench tools Note the file extension at the top of the interface. A CATIA drawing is saved as a file with the .CATDrawing file name extension.



Drafting Toolbars and Objects Student book reference: Student Guide: Drafting Toolbars and Objects



Talk to the students:



Summarize the tools without going into details. Many will be covered later.



Start a New Drawing Student book reference: Student Guide: Start a New Drawing



Starting a Drawing with a Blank Sheet Student book reference: Student Guide: Setting the Drawing Sheet Format and Drafting Standards, Starting a Drawing with a Blank Sheet



Talk to the students: Identify the steps to create a new drawing. Step2: Once a new drawing is started, you are prompted to define properties of the drawing. You can set the following items: ==> Standard: ISO, ANSI, or JIS standards ==> Paper format: A, B, C, or A0, A1, A2, etc. ==> Orientation: Landscape or portrait



Ask the students:



Ensure there are no questions before moving onto the next step.
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CATIA V5 Fundamentals Your Notes: Sheet Properties Student book reference: Student Guide: Sheet Properties



Talk to the students:



Use the Third angle standard option generate the views on the sheet using the 3rd angle projection method (ANSI).



“File > New from” Student book reference: Student Guide: “File > New from”



Talk to the students:



You can use these files to start new drawings. To do so, select “File > New from” menu. Select the sample file, rename the drawing and delete the existing elements in the drawing. You can start working in this new file. These files contain the following information: A. Title Blocks of the organization, which may contain information such as name of the organization, part number, revision number etc. B. Drafting standards such as dimension styles, default line types, line colors etc.
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CATIA V5 Fundamentals Your Notes: Drawing Title Blocks (1/2) Talk to the students: Title blocks in CATIA can be generated in two ways: A. You can manually create a template drawing using geometry tools. You can then use the template as a start drawing for all new drawings. Click File > New From in the menu bar to create a file from a template. B. You can enter customized macros to generate the title block. CATIA supplies some sample title blocks that can be used as a starting point to generate unique ones for your company.



Talk to the students: Title blocks in CATIA can be generated in two ways: A. You can manually create a template drawing using geometry tools. You can then use the template as a start drawing for all new drawings. Click File > New From in the menu bar to create a file from a template. B. You can enter customized macros to generate the title block. CATIA supplies some sample title blocks that can be used as a starting point to generate unique ones for your company.



Talk to the students:



Title blocks in CATIA can be generated in two ways: A. You can manually create a template drawing using geometry tools. You can then use the template as a start drawing for all new drawings. Click File > New From in the menu bar to create a file from a template. B. You can enter customized macros to generate the title block. CATIA supplies some sample title blocks that can be used as a starting point to generate unique ones for your company.



Drawing Title Blocks (2/2) Student book reference: Student Guide: Drawing Title Blocks (2/2)



Talk to the students:



Identify the steps to apply a title block. Step 2: The Insert Frame and Title Block window appears, displaying the default styles and sample macros.



2D Catalogs Student book reference: Student Guide: Introduction to 2D Catalogs



Talk to the students: A 2D component is a re-usable set of geometry and annotations. This component is stored in a CATDrawing referred by the catalog. The 2D component can be instantiated several times, each instance providing a component with a specific orientation, position and scale. You can update the instances to reflect the changes made in original 2D component.
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CATIA V5 Fundamentals Your Notes: Inserting Catalog Items (1/2) Student book reference: Student Guide: Inserting Catalog Items(1/2)



Talk to the students:



Describe the steps



Inserting Catalog Items (2/2) Student book reference: Student Guide: Inserting Catalog Items(2/2)



Talk to the students: Describe the steps



Create Views Student book reference: Student Guide: Create Views



Types of Views Student book reference: Student Guide: Types of Views



Talk to the students: Views represent a part in different orientations so that its design intent can be fully conveyed. Two types of views can be created in CATIA: A. Associative (i.e., linked to 3D models), which are called Generated Views. B. Non-associative (i.e., not linked to 3D models), which are called Draw Views.



Creating a Front View (1/2) Student book reference: Student Guide: Creating a Front View (1/2)



Talk to the students:



When you create views individually, you typically create a front view first. It can be created from a part, sub-body of a part, product, or sub-part of a product. Identify the steps to create a front view. The Front View is used as the defining view, while creating projection views.
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CATIA V5 Fundamentals Your Notes: Creating a Front View (2/2) Student book reference: Student Guide: Creating a Front View (2/2)



Talk to the students:



Identify the steps to create a front view.



Using the Compass Student book reference: Student Guide: Using the Compass (1/3), (2/3), (3/3)



Talk to the students: The compass enables you to reorient a view as needed for your design intent. This functionality only exists during the creation of the front view. You can perform the following actions using the compass: A. Click the up, down, left, and right arrows to flip the background plane view 90 degrees. B. You can rotate the view by setting a rotation angle or rotating freely. on the same plane. The 30 degrees increment can be changed by right mouse clicking the dial, which accesses the contextual menu. C. You can rotate the view by setting a rotation angle or rotating freely. Once you set the view, click on the dial center or anywhere on sheet to generate the front view.



About the Projection Plane Student book reference: Student Guide: About the Projection Plane



Talk to the students: You can use planar surface of a part to define the projection plane while creating a front view. After the creation of the view no link exists between the selected face in the 3D part and the view. For surface geometry which does not have planar surface, you can create a temporary plane, define the front view and delete the plane afterwards.
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CATIA V5 Fundamentals Your Notes: Adding Projection Views Student book reference: Student Guide: Adding Projection Views



Talk to the students:



After placing the initial front view, projection views (e.g., top, bottom, right, and left) can be added quickly using the front view as a reference. Identify the steps to place a projection view.



Adding an Isometric View Student book reference: Student Guide: Adding an Isometric View



Talk to the students: The isometric view that is created in a drawing is solely dependant on the orientation of the model in part mode and the reference surface selected. Identify the steps to add an isometric view.



Generating views using the View Wizard (1/2) Student book reference: Student Guide: View Wizard, Generating views using the View Wizard (1/3)



Talk to the students: The View Wizard enables you to quickly create the following: A. Standard view layouts, including: a. Front, Top, Left b. Front, Bottom, Right c. All views B. Custom view layouts, including: a. Adding views to create a specific view configuration. b. Deleting and rearranging the views as needed. The View Wizard enables you to quickly define a view layout, using only an initial plane or planar surface to define the front view. Identify the steps used to define a view layout. Views can be removed from the layout by right clicking on the view and clicking Delete from the contextual menu.
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CATIA V5 Fundamentals Your Notes: Generating views using the View Wizard (2/2) Student book reference: Student Guide: Generating views using the View Wizard (2/3), (3/3)



Talk to the students: Identify the steps used to define a view layout. Step 5: A preview of the Front view appears in the Part Design workbench, when pre-selected (i.e., highlighted) by the cursor.



CGR Views Student book reference: Student Guide: Different Modes of View Generation, CGR Views



Talk to the students: Exact generation mode will be the best option in most cases. All types of views can be generated using this option. There are a few cases where the Exact view generation mode is not appropriate: - In the case of assemblies involving large amount of data, generating exact views may consume too much memory. - Some elements from V4 .model documents (such as dittos, surfaces, etc.) are not supported. CGR views are generated using the CGR format. These views are useful when dealing with large products or assemblies involving large amounts of data. Approximate views are not as precise as exact views, but this generation mode reduces memory consumption. Raster views are generated as images. This enables you to quickly generate overall views for large products or assemblies. CGR views are generated using the CGR format (CATIA Graphical Representation). A CGR format only contains a graphical representation of the geometry, which is available with the Visualization mode. Advantages of CGR Views are: 1.Optimize memory consumption when generating and handling projection views for large products or assemblies. 2.Generate views from third-party data, as well as from polyhedral elements (such as dittos, surfaces, etc.) in V4 .model documents. Disadvantages of CGR Views are: 1.CGR views are not as high in quality as exact views. 2.You cannot project 3D elements such as wireframe, points, etc. on CGR views. 3.You cannot create section views, detail views, breakout views, unfolded views, views from 3D using CGR Mode.
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CATIA V5 Fundamentals Your Notes: Which Elements Will Be Projected? Student book reference: Student Guide: Which Elements Will Be Projected?



Talk to the students:



For a very general case, creating projections from 3D in Exact mode, all the elements from CATPart (3D solid and 3D wireframe) will be generated provided you have set the displayed options. While creating a projection view from a CATIA V4 Model Exact Solid (SolidE), Skin (*SKI) and faces (*FAC) will be projected. Other elements such as surface, volume and wireframe (*SUR, *VOL, *CRV, *CCV, *LN, *PT, *CPT, *PLN, *POL) will not be projected.



Create Dimensions and Annotations Student book reference: Student Guide: Create Dimensions and Annotations



Types of Dimension Locators (1/2) Student book reference: Student Guide: Types of Dimension Locators (1/2)



Talk to the students:



While applying a manual dimension, depending on the geometry, there is a possibility of creating different types of dimensions to describe the same entity. When a manual dimension icon is selected the Tools Palette toolbar appears to further refine the type of dimension to be created. CATIA enables you to locate manual dimensions with five types of positioning tools: A. Projection Dimensions: The placement of the cursor determines the dimension that will be created. B. Forced on element: Regardless of the cursor placement, the dimension is forced to be parallel with the element selected.
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CATIA V5 Fundamentals Your Notes: Types of Dimension Locators (2/2) Student book reference: Student Guide: Types of Dimension Locators (2/2)



Talk to the students:



CATIA enables you to locate manual dimensions with five types of positioning tools: C. Forced Horizontal: Regardless of cursor placement, the dimension is forced horizontal to the element selected. D. Forced Vertical: Regardless of cursor placement, the dimension is forced vertical to the element selected. E. Force Dimension along a direction: Place the dimension with respect to other entities. F. True length: Regardless of the view orientation, the dimension is the exact length of the selected 3D element. G. Intersection Point Detected: Create a dimension based on intersection of geometry.



Creating Dimensions (1/2) Student book reference: Student Guide: Creating Dimensions (1/2)



Talk to the students:



Do not describe in detail. To be coverered in following slides.



Creating Dimensions (2/2) Student book reference: Student Guide: Creating Dimensions (2/2)



Talk to the students: Do not describe in detail. To be coverered in following slides.



Dimensioning a Length Student book reference: Student Guide: Dimensioning a Length



Talk to the students:



Identify the steps used to create a length dimension.
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CATIA V5 Fundamentals Your Notes: Dimensioning a Distance Student book reference: Student Guide: Dimensioning a Distance



Talk to the students:



Identify the steps used to create a distance dimension.



Dimensioning a Hole Student book reference: Student Guide: Dimensioning a Hole



Talk to the students: Identify the steps used to dimenison holes.



Dimensioning a True Length Student book reference: Student Guide: Dimensioning a True Length



Talk to the students:



Identify the steps used to dimenison true length.



Dimensioning a Simple Angle Student book reference: Student Guide: Dimensioning a Simple Angle



Talk to the students: Identify the steps used to dimension an angle.



Dimensioning a Simple Radius Student book reference: Student Guide: Dimensioning a Simple Radius



Talk to the students: This dimension could also be created by using the Radius Dimensions icon. Identify the steps used to create a radius dimension. Most dimensions can be created using the Dimensions icon and contextual menus.
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CATIA V5 Fundamentals Your Notes: Dimensioning a Diameter Student book reference: Student Guide: Dimensioning a Diameter



Talk to the students:



Identify the steps used to create a diameter dimension.



Dimensioning a Chamfer Student book reference: Student Guide: Dimensioning a Chamfer



Talk to the students: Identify the steps used to create a chamfer dimenison.



Dimensioning a Thread Student book reference: Student Guide: Dimensioning a Thread



Talk to the students: Thread features need to be created in the model to create this type of dimension. Thread dimensions can be created for: A. Top views. B. Side views. Identify the steps used to dimension a thread.



Multiple Dimensions Student book reference: Student Guide: Chained Dimensions, Stacked Dimensions, Cumulated Dimensions



Talk to the students:



Select the relevant multiple dimension icon (Chained, Stacked, Cumulated). Select the origin point or edge of your cumulated system. Select all the other points or edges of your cumulated system (as many as you require). Select anywhere on the drawing to complete the dimension creation.
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CATIA V5 Fundamentals Your Notes: Dimension and Numerical Properties Student book reference: Student Guide: Dimension Properties



Talk to the students:



You can control the display of dimensions by using the Dimension Properties toolbar. You can customize the following areas of a dimension: A. Dimension line: Set the display of the dimension line with respect to the dimension. B. Tolerance description: Displays the dimension using a tolerance scheme. C. Tolerance: Changes the tolerance value for the dimension. D. Numerical display description: Displays the dimension in a particular unit. E. Precision: Sets the precision of the dimension.



Annotations Student book reference: Student Guide: Annotations



Talk to the students:



In addition to creating dimensions in a drawing, you can add notes and annotations to it. The Text toolbar contains the following tools: A. Text: Create a textbox with no leader. B. Text with Leader: Create a textbox with a leader. C. Replicate text: Create a copy of an existing text box and attribute link to geometry. D. Balloons: Creates a text balloon. E. Datum Target: Creates a datum target. F. Text template: Places a predefined text template.



Ask the students:



Ensure there are no questions before moving onto the next step.



Create Additional Views Student book reference: Student Guide: Create Additional Views
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CATIA V5 Fundamentals Your Notes: Section Views and Section Cuts Student book reference: Student Guide: Section Views and Section Cuts



Talk to the students:



Identify the difference between a section cut and a section view. Note that section cuts can also be created as simple or complex, aligned or offset.



Adding Section Views Student book reference: Student Guide: Adding a Simple Section View on a Drawing, Creating a Section View Using a 3D Profile Definition



Talk to the students: Identify the steps to create a simple offset section view. The view that the section view is cut from must be the active view; it does not necessarily have to be the front view as is the case in this example. A view is active when the view name is underlined in the specification tree. If the frame option is on then the frame color around the active view is red. If the axis option is on then the active view will have a blue axis visible. Step 2. Several points can be defined to create a “broken line” profile. A preview is displayed after double-click. You can create a section view by using a 3D profile or 3D plane as sectioning element. The advantage of using a 3D element to define a section view is that you can constrain this element with the part geometry. Hence section profile will modify automatically if basic geometry changes. Now lets take a look at some additional views you can create to help detail a drawing.



Adding a Detail View Student book reference: Student Guide: Adding a Detail View



Talk to the students: A detail view is defined by a “callout” on an existing view. New view is created with enlarged area inside the “callout”. Describe the steps. The default enlargement is two times the scale of the defining view To change the default enlargement of the detail view, select Properties in the contextual menu and Parameters in View menu.
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CATIA V5 Fundamentals Your Notes: Creating a Clipping View Student book reference: Student Guide: Creating a Clipping View



Talk to the students:



Clipping commands use 3D Boolean operation between 3D geometry and clipping profile. You can clip a view using circular callout or Sketched Profile. Describe the steps.



Creating a Broken View Student book reference: Student Guide: Creating a Broken View



Talk to the students:



A broken view is defined by adding the break lines to determine an area of the view that will be removed. Describe the steps. A view can contain multiple break definitions provided the definition is in the same direction and the two breaks do not overlap.



Creating a Breakout View Student book reference: Student Guide: Creating a Breakout View



Talk to the students: A breakout view allows the creation of a local cut (by a plane) in order to see the inside of a part without cutting it totally. Describe the steps.



Adding an Auxiliary View Student book reference: Student Guide: Creating a Auxiliary View



Talk to the students:



An auxiliary view is a view created in a given direction which is not a direction that can be obtained with a standard view. Describe the steps.



View Modifications Student book reference: Student Guide: View Modifications
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CATIA V5 Fundamentals Your Notes: Repositioning Views (1/5) Student book reference: Student Guide: Repositioning Views (1/5)



Talk to the students:



Identify the ways to reposition a view. More detail on each method is provided on the next slides.



Repositioning Views (2/5) Student book reference: Student Guide: Repositioning Views (2/5)



Talk to the students: The Set Relative Positioning option enables you to move a view based on its relative location to various elements (e.g., point, line, view frame). Identify the steps used to reposition a view, using the Set Relative Position option. The direction positioning line itself can be used to align the view with respect to an edge. In order to align the view, select the line and the corresponding edge.



Repositioning Views (3/5) Student book reference: Student Guide: Repositioning Views (3/5)



Talk to the students:



The Position Independently of Reference View option enables you to reposition a view without being constrained by its parent view. Identify the steps to position a view independently.



Repositioning Views (4/5) Student book reference: Student Guide: Repositioning Views (4/5)



Talk to the students: The Superpose option enables you to superimpose a view onto another view. Identify the steps to superimpose a view.
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CATIA V5 Fundamentals Your Notes: Repositioning Views (5/5) Student book reference: Student Guide: Repositioning Views (5/5)



Talk to the students:



The Align Views Using Elements option enables you to align a view with another view based on similar geometry between the two. Identify the steps used to align views.



Deleting Views Student book reference: Student Guide: Deleting Views



Talk to the students: Once you select the view (s) you want to remove, use one of the following methods to delete the view (s): A. Click Edit > Delete to delete the selected view (s). B. Click Delete from the contextual menu. C. Press the key on the keyboard to delete the selected views. In CATIA you are able to delete views that have children views associated to it. The child view becomes an independent view once its parent is deleted.



View Properties Student book reference: Student Guide: View Properties



Talk to the students: Use the following steps to modify the properties of a view: 1. Right click on a view in the specification tree or in the view frame. Click Properties from the pop-up menu. The Properties window appears. 2. Use the View and Graphic tabs to change the required options. The following properties are modified in this example: ==> View name ==> Fillets on dress-up features ==> Visualization to remove the frame 3. The view is modified as shown.
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CATIA V5 Fundamentals Your Notes: Modifying the Links of a View (1/2) Student book reference: Student Guide: Modifying the Links of a View (1/2)



Talk to the students:



You can change the content of a view using Modify Links command. Use the following steps to modify the links: Activate the view you want to modify and select Modify Links from contextual menu. Switch to the Product file pointed by the view. Multi select the components from the tree which you want to project.



Modifying the Links of a View (2/2) Student book reference: Student Guide: Modifying the Links of a View (2/2)



Talk to the students: Switch to the CATDrawing File again. Select Add all and select OK. Update the drawing.



Replacing the Projection Plane of a View (1/2) Student book reference: Student Guide: Replacing the Projection Plane of a View (1/2)



Talk to the students: You change the definition of the projection plane of a front view, isometric view or view from 3D. Use the following steps to replace the projection plane: Activate the view and select Modify Projection Plane from the contextual menu. Switch to the Part Document that contains the reference geometry. Select the new projection plane.



Replacing the Projection Plane of a View (2/2) Student book reference: Student Guide: Replacing the Projection Plane of a View (2/2)



Talk to the students:



Modify the view definition using the manipulator and place the view. Update the drawing so that the changes will propagate to all secondary views of the modified view. You need to reposition the secondary views. You can use the Synchronize View Definition command available in the contextual menu of detail and section views to propagate the changes.
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CATIA V5 Fundamentals Your Notes: Invert Section View Profile Student book reference: Student Guide: Invert Section View Profile



Talk to the students:



You can invert the section profile direction using the Edit /Replace toolbar. Double click on the Section view callout to open the ‘Edit/Replace’ toolbar which allows you to perform several kinds of modifications. Inverse the view direction: select the ‘Invert Profile direction’ icon. Click on the exit icon to apply the modifications.



Replace Section View Profile Student book reference: Student Guide: Replace Section View Profile



Talk to the students:



You can replace the section profile with a new one using the Edit/Replace toolbar. Double click on the Section view callout to open the ‘Edit/Replace’ toolbar which allows you to perform several kinds of modifications. Replace the profile: select the ‘Replace Profile’ icon. Create your new profile to replace the old one. Select on the ‘End Profile Edition’ icon to apply the modifications.



Show the students: It may be beneficial to modify views on a prepared drawing to reinforce what the students have learned in this lesson. Reposition views on a sheet: have views that are aligned, move the views and then break the alignment and move the views again. If time allows, demonstrate the element positioning dialog box as another way to reposition views. Also, modify a view’s properties as well as the sheet properties. Finally, modify a prepared section view to demonstrate the edit/replace toolbar.



Save the Drawing Student book reference: Student Guide: Save the Drawing
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CATIA V5 Fundamentals Your Notes: Matching the Drawing with the Modified 3D Part Student book reference: Student Guide: Matching the Drawing with the Modified 3D Part



Talk to the students:



Before saving any drawing, make sure it is updated with the latest information. If the Update icon (shown) is highlighted, it means the drawing has been updated to reflect the changes, that were made on the 3D parts it represents. In the part shown, for example, the width dimension has been changed from 40 to 60. Selecting the Update icon regenerates the view with the new dimensions.



Checking Links to 3D Parts (1/2) Student book reference: Student Guide: Checking Links to 3D Parts (1/2)



Talk to the students:



It is possible that a drawing may be opened without its referenced documents being loaded in session. This could be caused by a missing file or a global CATIA setting, the tree identifies this with broken icons. To update the drawing correctly the links of the drawing need to be verified. Identify the steps to load a missing document.



Checking Links to 3D Parts (2/2) Student book reference: Student Guide: Checking Links to 3D Parts (2/2)



Talk to the students:



Identify the steps to load a missing document.



Saving a Drawing Student book reference: Student Guide: Saving a Drawing



Talk to the students: Save a drawing the same way you save any other CATIA file. You can also use the Save As and Save management tools to store the drawing. Keep in mind that a drawing is dependent on the 3D part(s) it represents; therefore, it is important to verify that the parts and drawing is up to date with the most current information.



Ask the students:



Ensure there are no questions before moving onto the next step.
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CATIA V5 Fundamentals Your Notes: Print the Drawing Student book reference: Student Guide: Print the Drawing



Printing a Drawing Student book reference: Student Guide: Printing a Drawing



Talk to the students: Click File > Print or select the Print icon to print your drawing. The Print window contents enables you to customize the layout, page setup, and options. It also shows a print preview of the drawing.



Print User Interface (1/2) Student book reference:



D. Page Setup: Define the page size and characteristics.



Print User Interface (2/2) Student book reference:



C. Various
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Drawing Creation (Detailed Instructions), Drawing Creation (Limited Instructions), Drawing Creation



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. A demonstration of the topics covered should include, creating an empty drawing, and front, projection, and isometric views. Demonstrate the use of the compass and that the isometric view is based on the orientation of the 3D model. Using a different part, create another drawing, this time generate the views using the View Wizard. Add the overall dimensions and a title block to one of the drawings.



Talk to the students:



Present the exercises available to practice creating drawings. As a class, discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting).



Case Study: Drafting Student book reference: Student Guide: Case Study: Drafting



Talk to the students:



Review the requirements for the case study. Discuss as a class how the drawing will be created, what tools are needed to create the case study?



Drawing Creation (Detailed Instructions): Recap Student book reference: Student Guide: Drawing Creation (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Drawing Creation (Limited Instructions): Recap Student book reference: Student Guide: Drawing Creation (Limited Instructions): Recap



Talk to the students:



Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Drawing Creation: Recap Student book reference: Student Guide: Drawing Creation: Recap



Talk to the students: Discuss the different tools used in this exercise.



Ask the students: How did the students create the views (using the view wizard or manully)? What tools did the students use to dimension the drawing. Did they use the Dimension tool for all of them or did they use the specific tool for the type of dimenion needed? Ask if there are any questions regarding this exercise? Any difficulties?



Case Study: Base Recap Student book reference: Student Guide: Case Study: Base Recap



Talk to the students: Discuss the objectives of the case study. Review the process used to create the drawing. Ensure the students understand the process used to create the case study before beginning the master project.
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CATIA V5 Fundamentals Your Notes:



Lesson 10: Drafting (ISO) Case Study Student book reference: Student Guide: Case Study: Drafting, Design Intent, Stages in the Process



Talk to the students: Introduce the case study for the lesson. The base is part of the stand sub-assembly. Locate where the base is in the sub-assembly and where the subassemlby is in the main assembly. Identify the design intent for this model. 1. Standards are predefined formats for dimensions, annotations, and views, which provide a consistent interpretation of information. 2. The display of these items in a single view enables a better understanding of the model by showing depth and internal features. 3.This is typically required with any drawing. Identify the stages in the process.



Introduction to Generative Drafting Student book reference: Student Guide: Introduction to Generative Drafting



Talk to the students: Introduce the concept of Generative drafting.



General Process Student book reference: Student Guide: General Process



Talk to the students: The creation of a drawing for parts and assemblies can begin at any time in the design process. CATIA maintains an associative link between a drawing and the parts and assemblies it references. As the 3D part and assembly models evolve, the drawings automatically show the updated geometry.
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CATIA V5 Fundamentals Your Notes: Accessing the Workbench Student book reference: Student Guide: Accessing the Workbench



Talk to the students:



The drawings of parts and assemblies are created in CATIA using the Drafting workbench. It can be accessed in the following three ways: A. Start menu B. File menu C. New icon D. Workbench icon



The Drawing Environment Student book reference: Student Guide: The Drawing Environment



Talk to the students: The drawing environment, accessed through the Drafting workbench, consists of the following components: A. Specification tree: Contains sheet and view information. B. Sheet: Contains the drawing views, title block, annotations, dimensions, etc. The active view is underlined in the tree and enclosed in a red frame. C. Prompt: Displays instructions and requirements for tools as they are activated. Command line entries are also made here. D. Toolbars: Contains the Drafting workbench tools Note the file extension at the top of the interface. A CATIA drawing is saved as a file with the .CATDrawing file name extension.



Drafting Toolbars and Objects Student book reference: Student Guide: Drafting Toolbars and Objects



Talk to the students: Summarize the tools without going into details. Many will be covered later.



Start a New Drawing Student book reference: Student Guide: Start a New Drawing
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CATIA V5 Fundamentals Your Notes: Starting a Drawing with a Blank Sheet Student book reference: Student Guide: Setting the Drawing Sheet Format and Drafting Standards, Starting a Drawing with a Blank Sheet



Talk to the students: Identify the steps to create a new drawing. Step2: Once a new drawing is started, you are prompted to define properties of the drawing. You can set the following items: ==> Standard: ISO, ANSI, or JIS standards ==> Paper format: A, B, C, or A0, A1, A2, etc. ==> Orientation: Landscape or portrait



Ask the students:



Ensure there are no questions before moving onto the next step.



Sheet Properties Student book reference: Student Guide: Sheet Properties



Talk to the students:



Use the First angle standard option generates the views on the sheet using the First Angle projection method (ISO).



“File > New from” Student book reference: Student Guide: “File > New from”



Talk to the students:



You can use these files to start new drawings. To do so, select “File > New from” menu. Select the sample file, rename the drawing and delete the existing elements in the drawing. You can start working in this new file.
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CATIA V5 Fundamentals Your Notes: Drawing Title Blocks (1/2) Talk to the students: Title blocks in CATIA can be generated in two ways: A. You can manually create a template drawing using geometry tools. You can then use the template as a start drawing for all new drawings. Click File > New From in the menu bar to create a file from a template. B. You can enter customized macros to generate the title block. CATIA supplies some sample title blocks that can be used as a starting point to generate unique ones for your company.



Talk to the students: Title blocks in CATIA can be generated in two ways: A. You can manually create a template drawing using geometry tools. You can then use the template as a start drawing for all new drawings. Click File > New From in the menu bar to create a file from a template. B. You can enter customized macros to generate the title block. CATIA supplies some sample title blocks that can be used as a starting point to generate unique ones for your company.



Talk to the students:



Title blocks in CATIA can be generated in two ways: A. You can manually create a template drawing using geometry tools. You can then use the template as a start drawing for all new drawings. Click File > New From in the menu bar to create a file from a template. B. You can enter customized macros to generate the title block. CATIA supplies some sample title blocks that can be used as a starting point to generate unique ones for your company.



Drawing Title Blocks (2/2) Student book reference: Student Guide: Drawing Title Blocks (2/2)



Talk to the students:



Identify the steps to apply a title block. Step 2: The Insert Frame and Title Block window appears, displaying the default styles and sample macros.



2D Catalogs Student book reference: Student Guide: Introduction to 2D Catalogs



Talk to the students: A 2D component is a re-usable set of geometry and annotations. This component is stored in a CATDrawing referred by the catalog. The 2D component can be instantiated several times, each instance providing a component with a specific orientation, position and scale.
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CATIA V5 Fundamentals Your Notes: Inserting Catalog Items (1/2) Student book reference: Student Guide: Inserting Catalog Items(1/2)



Talk to the students:



Describe the steps



Inserting Catalog Items (2/2) Student book reference: Student Guide: Inserting Catalog Items(2/2)



Talk to the students: Describe the steps



Create Views Student book reference: Student Guide: Create Views



Types of Views Student book reference: Student Guide: Types of Views



Talk to the students: Views represent a part in different orientations such that its design intent can be fully conveyed. Two types of views can be created in CATIA: A. Associative (i.e., linked to 3D models), which are called Generated Views. B. Non-associative (i.e., not linked to 3D models), which are called Draw Views.



What is a Front View? Student book reference: Student Guide: Types of Views



Talk to the students:



Identify the icons available to create views.
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CATIA V5 Fundamentals Your Notes: Creating a Front View (1/2) Student book reference: Student Guide: Creating a Front View (1/2)



Talk to the students:



When you create views individually, you typically create a front view first. It can be created from a part, sub-body of a part, product, or sub-part of a product. Identify the steps to create a front view. The Front View is used as the defining view when creating projection views.



Creating a Front View (2/2) Student book reference: Student Guide: Creating a Front View (2/2)



Talk to the students: Identify the steps to create a front view.



Using the Compass Student book reference: Student Guide: Using the Compass (1/3), (2/3), (3/3)



Talk to the students: The compass enables you to reorient a view as needed for your design intent. This functionality only exists during the creation of the front view. You can perform the following actions using the compass: A. Click the up, down, left, and right arrows to flip the background plane view 90 degrees. B. Click the center left and right arrows to rotate the view 30 degrees on the same plane. The 30 degrees increment can be changed by right mouse clicking the dial, which accesses the contextual menu. C. You can rotate the view by setting a rotation angle or rotating freely. When finished setting the view, click on the dial center or anywhere on sheet to generate the front view.
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CATIA V5 Fundamentals Your Notes: About the Projection Plane Student book reference: Student Guide: About the Projection Plane



Talk to the students:



You can use planar surface of a part to define the projection plane while creating a front view. After the creation of the view no link exists between the selected face in the 3D part and the view. For surface geometry which does not have planar surface, you can create a temporary plane, define the front view and delete the plane afterwards.



Adding Projection Views Student book reference: Student Guide: Adding Projection Views



Talk to the students:



After placing the initial front view, projection views (e.g., top, bottom, right, and left) can be added quickly using the front view as a reference. Identify the steps to place a projection view.



Adding an Isometric View Student book reference: Student Guide: Adding an Isometric View



Talk to the students: The isometric view that is created in a drawing is solely dependant on the orientation of the model in part mode and the reference surface selected. Identify the steps to add an isometric view.
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CATIA V5 Fundamentals Your Notes: Generating views using the View Wizard (1/2) Student book reference: Student Guide: View Wizard, Generating views using the View Wizard (1/3)



Talk to the students: The View Wizard enables you to quickly create the following: A. Standard view layouts, including: a. Front, Top, Left b. Front, Bottom, Right c. All views B. Custom view layouts, including: a. Adding views to create a specific view configuration. b. Deleting, and rearranging the views as needed. The View Wizard enables you to quickly define a view layout using only an initial plane or planar surface to define the front view. Identify the steps used to define a view layout. Views can be removed from the layout by right clicking on the view and clicking Delete from the contextual menu.



Generating views using the View Wizard (2/2) Student book reference: Student Guide: Generating views using the View Wizard (2/3), (3/3)



Talk to the students:



Identify the steps used to define a view layout. Step 5: A preview of the Front view appears in the Part Design workbench when pre-selected (i.e., highlighted) by the cursor.
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CATIA V5 Fundamentals Your Notes: CGR Views Student book reference: Student Guide: Different Modes of View Generation, CGR Views



Talk to the students:



Exact generation mode will be the best option in most cases. All types of views can be generated using this option. There are a few cases where the Exact view generation mode is not appropriate: - In the case of assemblies involving large amount of data, generating exact views may consume too much memory. - Some elements from V4 .model documents (such as dittos, surfaces, etc.) are not supported. CGR views are generated using the CGR format. These views are useful when dealing with large products or assemblies involving large amounts of data. Approximate views are not as precise as exact views, but this generation mode reduces memory consumption. Raster views are generated as images. This enables you to quickly generate overall views for large products or assemblies. CGR views are generated using the CGR format (CATIA Graphical Representation). A CGR format only contains a graphical representation of the geometry, which is available with the Visualization mode. Advantages of CGR Views are: 1.Optimize memory consumption when generating and handling projection views for large products or assemblies. 2.Generate views from third-party data, as well as from polyhedral elements (such as dittos, surfaces, etc.) in V4 .model documents. Disadvantages of CGR Views are: 1.CGR views are not as high in quality as exact views. 2.You cannot project 3D elements such as wireframe, points, etc. on CGR views. 3.You cannot create section views, detail views, breakout views, unfolded views, views from 3D using CGR Mode.



Which Elements Will Be Projected? Student book reference: Student Guide: Which Elements Will Be Projected?



Talk to the students: For a very general case, creating projections from 3D in Exact mode, all the elements from CATPart (3D solid and 3D wireframe) will be generated provided you have set the displayed options. While creating a projection view from a CATIA V4 Model Exact Solid (SolidE), Skin (*SKI) and faces (*FAC) will be projected. Other elements such as surface, volume and wireframe (*SUR, *VOL, *CRV, *CCV, *LN, *PT, *CPT, *PLN, *POL) will not be projected.
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CATIA V5 Fundamentals Your Notes: Create Dimensions and Annotations Student book reference: Student Guide: Create Dimensions and Annotations



Dimensions Student book reference: Student Guide: Dimensions



Dimensions System Student book reference: Student Guide: Dimensions System



Talk to the students: Identify the types of dimenisoning systems possible. Detail on each will be provided in the next slides.



Types of Dimension Locators (1/2) Student book reference: Student Guide: Types of Dimension Locators (1/2)



Talk to the students:



When applying a manual dimension, depending on the geometry, there is the possibility that many different types of dimensions can be created to describe the same entity. When a manual dimension icon is selected the Tools Palette toolbar appears to further refine the type of dimension to be created. CATIA enables you to locate manual dimensions with five types of positioning tools: A. Projection Dimensions: The placement of the cursor determines the dimension that will be created. B. Forced on element: Regardless of the cursor placement, the dimension is forced to be parallel with the element selected.
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CATIA V5 Fundamentals Your Notes: Types of Dimension Locators (2/2) Student book reference: Student Guide: Types of Dimension Locators (2/2)



Talk to the students:



CATIA enables you to locate manual dimensions with five types of positioning tools: C. Forced Horizontal: Regardless of cursor placement, the dimension is forced horizontal to the element selected. D. Forced Vertical: Regardless of cursor placement, the dimension is forced vertical to the element selected. E. Force Dimension along a direction: Place the dimension with respect to other entities. F. True length: Regardless of the view orientation, the dimension is the exact length of the 3D element selected. G. Intersection Point Detected: Create a dimension based on intersection of geometry.



Creating Dimensions (1/2) Student book reference: Student Guide: Creating Dimensions (1/2)



Talk to the students:



Do not describe in detail. To be coverered in following slides.



Creating Dimensions (2/2) Student book reference: Student Guide: Creating Dimensions (2/2)



Talk to the students: Do not describe in detail. To be coverered in following slides.



Dimensioning a Length Student book reference: Student Guide: Dimensioning a Length



Talk to the students:



Identify the steps used to create a length dimension.
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CATIA V5 Fundamentals Your Notes: Dimensioning a Distance Student book reference: Student Guide: Dimensioning a Distance



Talk to the students:



Identify the steps used to create a distance dimension.



Dimensioning a Hole Student book reference: Student Guide: Dimensioning a Hole



Talk to the students: Identify the steps used to dimenison holes.



Dimensioning a True Length Student book reference: Student Guide: Dimensioning a True Length



Talk to the students:



Identify the steps used to dimenison true length.



Dimensioning a Simple Angle Student book reference: Student Guide: Dimensioning a Simple Angle



Talk to the students: Identify the steps used to dimension an angle.



Dimensioning a Simple Radius Student book reference: Student Guide: Dimensioning a Simple Radius



Talk to the students: This dimension could also be created by using the Radius Dimensions icon. Identify the steps used to create a radius dimension. Most dimensions can be created using the Dimensions icon and contextual menus.
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CATIA V5 Fundamentals Your Notes: Dimensioning a Diameter Student book reference: Student Guide: Dimensioning a Diameter



Talk to the students:



Identify the steps used to create a diameter dimension.



Dimensioning a Chamfer Student book reference: Student Guide: Dimensioning a Chamfer



Talk to the students: Identify the steps used to create a chamfer dimenison.



Dimensioning a Thread Student book reference: Student Guide: Dimensioning a Thread



Talk to the students: Thread features need to be created in the model to create this type of dimension. Thread dimensions can be created for: A. Top views. B. Side views. Identify the steps used to dimension a thread.



Multiple Dimensions Student book reference: Student Guide: Chained Dimensions, Stacked Dimensions, Cumulated Dimensions



Talk to the students:



Select the relevant multiple dimension icon (Chained, Stacked, Cumulated). Select the origin point or edge of your cumulated system. Select all the other points or edges of your cumulated system (as many as you require). Select anywhere on the drawing to complete the dimension creation.
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CATIA V5 Fundamentals Your Notes: Dimension and Numerical Properties Student book reference: Student Guide: Dimension Properties



Talk to the students:



You can control the display of dimensions by using the Dimension Properties toolbar. You can customize the following areas of a dimension: A. Dimension line: Set the display of the dimension line with respect to the dimension. B. Tolerance description: Displays the dimension using a tolerance scheme. C. Tolerance: Changes the tolerance value for the dimension. D. Numerical display description: Displays the dimension in a particular unit. E. Precision: Sets the precision of the dimension.



Annotations Student book reference: Student Guide: Annotations



Talk to the students:



In addition to creating dimensions in a drawing, you can add notes and annotations to it. The Text toolbar contains the following tools: A. Text: Create a textbox with no leader. B. Text with Leader: Create a textbox with a leader. C. Replicate text: Create a copy of an existing text box and attribute link it to geometry. D. Balloons: Creates a text balloon. E. Datum Target: Creates a datum target. F. Text template: Place a predefined text template.



Ask the students:



Ensure there are no questions before moving onto the next step.



Create Additional Views Student book reference: Student Guide: Create Additional Views
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CATIA V5 Fundamentals Your Notes: Section Views and Section Cuts Student book reference: Student Guide: Section Views and Section Cuts



Talk to the students:



Identify the difference between a section cut and a section view. Note that section cuts can also be created as simple or complex, aligned or offset.



Adding Section Views Student book reference: Student Guide: Adding a Simple Section View on a Drawing, Creating a Section View Using a 3D Profile Definition



Talk to the students: Identify the steps to create a simple offset section view. The view that the section view is cut from must be the active view; it does not necessarily have to be the front view as is the case in this example. A view is active when the view name is underlined in the specification tree. If the frame option is on then the frame color around the active view is red. If the axis option is on then the active view will have a blue axis visible. Step 2. Several points can be defined to create a “broken line” profile. A preview is displayed after double-click. You can create a section view by using a 3D profile or 3D plane as sectioning element. The advantage of using a 3D element to define a section view is that you can constrain this element with the part geometry. Hence section profile will modify automatically if basic geometry changes. Now lets take a look at some additional views you can create to help detail a drawing.



Adding a Detail View Student book reference: Student Guide: Adding a Detail View



Talk to the students: A detail view is defined by a “callout” on an existing view. New view is created with enlarged area inside the “callout”. Describe the steps. The default enlargement is two times the scale of the defining view To change the default enlargement of the detail view, select Properties in the contextual menu and Parameters in View menu.
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CATIA V5 Fundamentals Your Notes: Creating a Clipping View Student book reference: Student Guide: Creating a Clipping View



Talk to the students:



Clipping commands use 3D Boolean operation between 3D geometry and clipping profile. You can clip a view using circular callout or Sketched Profile. Describe the steps.



Creating a Broken View Student book reference: Student Guide: Creating a Broken View



Talk to the students:



A broken view is defined by adding the break lines to determine an area of the view that will be removed. Describe the steps. A view can contain multiple break definitions provided the definition is in the same direction and the two breaks do not overlap.



Creating a Breakout View Student book reference: Student Guide: Creating a Breakout View



Talk to the students: A breakout view allows the creation of a local cut (by a plane) in order to see the inside of a part without cutting it totally. Describe the steps.



Adding an Auxiliary View Student book reference: Student Guide: Creating a Auxiliary View



Talk to the students:



An auxiliary view is a view created in a given direction which is not a direction that can be obtained with a standard view. Describe the steps.



View Modifications Student book reference: Student Guide: View Modifications
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CATIA V5 Fundamentals Your Notes: Repositioning Views (1/5) Student book reference: Student Guide: Repositioning Views (1/5)



Talk to the students:



Identify the ways to reposition a view. More detail on each method is provided on the next slides.



Repositioning Views (2/5) Student book reference: Student Guide: Repositioning Views (2/5)



Talk to the students: The Set Relative Positioning option enables you to move a view based on its relative location to various elements (e.g., point, line, view frame). Identify the steps used to reposition a view using the Set Relative Position option. The direction positioning line itself can be used to align the view with respect to an edge. Select the line and then the corresponding edge you want to align the view to.



Repositioning Views (3/5) Student book reference: Student Guide: Repositioning Views (3/5)



Talk to the students:



The Position Independently of Reference View option enables you to reposition a view without it being constrained by its parent view. Identify the steps to position a view independently.



Repositioning Views (4/5) Student book reference: Student Guide: Repositioning Views (4/5)



Talk to the students: The Superpose option enables you to superimpose a view onto another view. Identify the steps to superimpose a view.
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CATIA V5 Fundamentals Your Notes: Repositioning Views (5/5) Student book reference: Student Guide: Repositioning Views (5/5)



Talk to the students:



The Align Views Using Elements option enables you to align a view with another view based on similar geometry between the two. Identify the steps used to align views.



Deleting Views Student book reference: Student Guide: Deleting Views



Talk to the students: Once you select the view (s) you want to remove, use one of the following methods to delete the view (s): A. Click Edit > Delete to delete the selected view (s). B. Click Delete from the contextual menu. C. Press the key on the keyboard to delete the selected views. In CATIA you are able to delete views that have children views associated to it. The child view becomes an independent view once its parent is deleted.



View Properties Student book reference: Student Guide: View Properties



Talk to the students: Use the following steps to modify the properties of a view: 1. Right click on a view in the specification tree or in the view frame. Click Properties from the pop-up menu. The Properties window appears. 2. Use the View and Graphic tabs to change the required options. The following properties are modified in this example: ==> View name ==> Fillets on dress-up features ==> Visualization to remove the frame 3. The view is modified as shown.
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CATIA V5 Fundamentals Your Notes: Modifying the Links of a View (1/2) Student book reference: Student Guide: Modifying the Links of a View (1/2)



Talk to the students:



You can change the content of a view using Modify Links command. Use the following steps to modify the links: Activate the view you want to modify and select Modify Links from contextual menu. Switch to the Product file pointed by the view. Multi select the components from the tree which you want to project.



Modifying the Links of a View (2/2) Student book reference: Student Guide: Modifying the Links of a View (2/2)



Talk to the students: Switch to the CATDrawing File again. Select Add all and select OK. Update the drawing.



Replacing the Projection Plane of a View (1/2) Student book reference: Student Guide: Replacing the Projection Plane of a View (1/2)



Talk to the students: You change the definition of the projection plane of a front view, isometric view or view from 3D. Use the following steps to replace the projection plane: Activate the view and select Modify Projection Plane from the contextual menu. Switch to the Part Document that contains the reference geometry. Select the new projection plane.



Replacing the Projection Plane of a View (2/2) Student book reference: Student Guide: Replacing the Projection Plane of a View (2/2)



Talk to the students:



Modify the view definition using the manipulator and place the view. Update the drawing so that the changes will propagate to all secondary views of the modified view. You need to reposition the secondary views. You can use the Synchronize View Definition command available in the contextual menu of detail and section views to propagate the changes.
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CATIA V5 Fundamentals Your Notes: Invert Section View Profile Student book reference: Student Guide: Invert Section View Profile



Talk to the students:



You can invert the section profile direction using the Edit /Replace toolbar. Double click on the Section view callout to open the ‘Edit/Replace’ toolbar which allows you to perform several kinds of modifications. Inverse the view direction: select the ‘Invert Profile direction’ icon. Click on the exit icon to apply the modifications.



Replace Section View Profile Student book reference: Student Guide: Replace Section View Profile



Talk to the students:



You can replace the section profile with a new one using the Edit/Replace toolbar. Double click on the Section view callout to open the ‘Edit/Replace’ toolbar which allows you to perform several kinds of modifications. Replace the profile: select the ‘Replace Profile’ icon. Create your new profile to replace the old one. Select on the ‘End Profile Edition’ icon to apply the modifications.



Show the students: It may be beneficial to modify views on a prepared drawing to reinforce what the students have learned in this lesson. Reposition views on a sheet: have views that are aligned, move the views and then break the alignment and move the views again. If time allows, demonstrate the element positioning dialog box as another way to reposition views. Also, modify a view’s properties as well as the sheet properties. Finally, modify a prepared section view to demonstrate the edit/replace toolbar.



Save the Drawing Student book reference: Student Guide: Save the Drawing
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CATIA V5 Fundamentals Your Notes: Matching the Drawing with the Modified 3D Part Student book reference: Student Guide: Matching Drawing with Modified 3D Part



Talk to the students:



Before saving any drawing, it is a good idea to make sure that it is up to date with the most recent information. If the Update icon (shown) is highlighted, this means that the drawing must be updated to reflect the changes that were made on the 3D part it represents. In the part shown, for example, the width dimension has been changed from 40 to 60. Selecting the Update icon regenerates the view with the new dimensions.



Checking Links to 3D Parts (1/2) Student book reference: Student Guide: Checking Links to 3D Parts (1/2)



Talk to the students:



It is possible that a drawing may be opened without its referenced documents being loaded in session. This could be caused by a missing file or a global CATIA setting, the tree identifies this with broken icons. To update the drawing correctly the links of the drawing need to be verified. Identify the steps to load a missing document.



Checking Links to 3D Parts (2/2) Student book reference: Student Guide: Checking Links to 3D Parts (2/2)



Talk to the students:



Identify the steps to load a missing document.



Saving a Drawing Student book reference: Student Guide: Saving a Drawing



Talk to the students: You save a drawing the same way you would any other CATIA file. You can also use the Save As and Save management tools to store the drawing. Keep in mind that a drawing is dependent on the 3D part(s) it represents; therefore, it is important to verify that the parts and drawing is up to date with the most current information.



Ask the students:



Ensure there are no questions before moving onto the next step.
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CATIA V5 Fundamentals Your Notes: Print the Drawing Student book reference: Student Guide: Print the Drawing



Printing a Drawing Student book reference: Student Guide: Printing a Drawing



Talk to the students: Click File > Print or select the Print icon to print your drawing. The Print window contains enables you to customize the layout, page setup, and options. It also shows a print preview of the drawing.



Print User Interface (1/2) Student book reference:



D. Page Setup: Define the page size and characteristics.



Print User Interface (2/2) Student book reference:



C. Various
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CATIA V5 Fundamentals Your Notes: Exercise Overview Student book reference: Student Guide: Drawing Creation (Detailed Instructions), Drawing Creation (Limited Instructions), Drawing Creation



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first work on the exercises and then see the demonstration. A demonstration of the topics covered should include, creating an empty drawing, and front, projection, and isometric views. Demonstrate the use of the compass and that the isometric view is based on the orientation of the 3D model. Using a different part, create another drawing, this time generate the views using the View Wizard. Add the overall dimensions and a title block to one of the drawings.



Talk to the students:



Present the exercises available to practice creating drawings. As a class, discuss what will be involved in completing the exercises. What tools will they need to use? Inform the students where they have to save the models and where the required start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting).



Case Study: Drafting Student book reference: Student Guide: Case Study: Drafting



Talk to the students:



Review the requirements for the case study. Discuss as a class how the drawing will be created, what tools are needed to create the case study?



Drawing Creation (Detailed Instructions): Recap Student book reference: Student Guide: Drawing Creation (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?
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CATIA V5 Fundamentals Your Notes: Drawing Creation (Limited Instructions): Recap Student book reference: Student Guide: Drawing Creation (Limited Instructions): Recap



Talk to the students:



Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions regarding this exercise? Any difficulties?



Drawing Creation: Recap Student book reference: Student Guide: Drawing Creation: Recap



Talk to the students: Discuss the different tools used in this exercise.



Ask the students: How did the students create the views (using the view wizard or manully)? What tools did the students use to dimension the drawing. Did they use the Dimension tool for all of them or did they use the specific tool for the type of dimenion needed? Ask if there are any questions regarding this exercise? Any difficulties?



Case Study: Base Recap Student book reference: Student Guide: Case Study: Base Recap



Talk to the students: Discuss the objectives of the case study. Review the process used to create the drawing. Ensure the students understand the process used to create the case study before beginning the master project.
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